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Preface

Endeca® InFront enables businesses to deliver targeted experiences for any customer, every time, in
any channel. Utilizing all underlying product data and content, businesses are able to influence customer
behavior regardless of where or how customers choose to engage — online, in-store, or on-the-go.
And with integrated analytics and agile business-user tools, InFront solutions help businesses adapt
to changing market needs, influence customer behavior across channels, and dynamically manage a
relevant and targeted experience for every customer, every time.

InFront Workbench with Experience Manager provides a single, flexible platform to create, deliver,
and manage content-rich, multichannel customer experiences. Experience Manager allows non-technical
users to control how, where, when, and what type of content is presented in response to any search,
category selection, or facet refinement.

At the core of InFront is the Endeca MDEX Engine,™ a hybrid search-analytical database specifically
designed for high-performance exploration and discovery. InFront Integrator provides a set of extensible
mechanisms to bring both structured data and unstructured content into the MDEX Engine from a
variety of source systems. InFront Assembler dynamically assembles content from any resource and
seamlessly combines it with results from the MDEX Engine.

These components — along with additional modules for SEO, Social, and Mobile channel support —
make up the core of Endeca InFront, a customer experience management platform focused on delivering
the most relevant, targeted, and optimized experience for every customer, at every step, across all
customer touch points.

About this guide

This guide describes the major tasks involved in developing an Endeca application using the Rapid
Application Development (RAD) Toolkit for ASP.NET.

This guide assumes that you have read the Endeca Concepts Guide and that you are familiar with
Endeca’s terminology and basic concepts.

This guide covers the main features of the RAD Toolkit for ASP.NET. This guide is not a replacement
for the Endeca Basic Development Guide or the Endeca Advanced Development Guide.

Who should use this guide

This guide is intended for ASP.NET developers who are building Endeca applications using the Rapid
Application Development (RAD) Toolkit for ASP.NET.

This guide assumes that you are familiar with C#, the Microsoft .NET Framework, Microsoft Visual
Studio, and Web development concepts.

If you are a new user of the Endeca Information Access Platform and you are not familiar with developing
Endeca applications, read this guide in conjunction with the Endeca Basic Development Guide and
the Endeca Advanced Development Guide, available for download from the Endeca Developer Network
(EDeN) at http://eden.endeca.com. Those guides provide detailed feature descriptions that are not
fully covered in this version of the Endeca Developer's Guide for the RAD Toolkit for ASP.NET.
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If you are an existing user of the Endeca Information Access Platform and you are familiar with
developing Endeca applications, this guide should provide enough information to help you build a new
application using the RAD Toolkit for ASP.NET.

Also, see the Endeca API Reference for the RAD Toolkit for ASP.NET. In a default installation, this is
located in the C:\Endeca\RADToolkits\version\ASP.NET\doc directory. This file contains
reference information for the RAD API, the Endeca data source, and Endeca user interface controls.

Conventions used in this guide

This guide uses the following typographical conventions:

Code examples, inline references to code elements, file names, and user input are set in monospace
font. In the case of long lines of code, or when inline monospace text occurs at the end of a line, the
following symbol is used to show that the content continues on to the next line: =

When copying and pasting such examples, ensure that any occurrences of the symbol and the
corresponding line break are deleted and any remaining space is closed up.

Contacting Endeca Customer Support

The Endeca Support Center provides registered users with important information regarding Endeca
software, implementation questions, product and solution help, training and professional services
consultation as well as overall news and updates from Endeca.

You can contact Endeca Standard Customer Support through the Support section of the Endeca
Developer Network (EDeN) at http://eden.endeca.com.

Endeca® RAD Toolkit for ASPNET Developer's Guide Endeca Confidential
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Chapter 1

Installing and uninstalling the RAD Toolkit
for ASP.NET

This section provides system prerequisites, installation procedures, and deployment procedures for
the Endeca RAD Toolkit for ASP.NET.

Prerequisites for installing the RAD Toolkit for ASP.NET

This topic describes the software prerequisites that must be in place before you install the RAD Toolkit
for ASP.NET.

Software compatibility

To determine the compatibility of the RAD Toolkit for ASP.NET with other Endeca installation packages,
see the Endeca InFront Compatibility Matrix available on EDeN.

Operating system requirements

The RAD Toolkit for ASP.NET is supported on Windows Server 2003 and Windows Server 2008.

Software requirements

The following software must be installed before you install the RAD Toolkit for ASP.NET:
* Microsoft .NET Framework. The RAD Toolkit for ASP.NET supports the following versions of the
Microsoft .NET Framework (both 32-bit and 64-bit): 2.0 with SP1, 3.0, and 3.5.
* Microsoft Visual Studio 2005 with Service Pack 1 (any edition) or Visual Studio 2008.

< On machines running the RAD Toolkit for ASP.NET reference application, you need Internet
Information Services (IIS) 5.1 or later.

- . . . .
77 Note: The Endeca Presentation and Logging APIs for .NET are part of the RAD Toolkit installation
and are installed into <installation
path>\Endeca\RADToolkits\<version>\ASP_NET\bin.

Unsupported software

Microsoft .NET Framework version 1.1 is not supported.
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Optional software

If you want to use the Analytics capabilities of the Endeca data source controls, refer to Enabling
Endeca Analytics.

Installing the RAD Toolkit for ASP.NET

This topic describes how to install the Endeca RAD Toolkit for ASP.NET.
Before starting this procedure, see "Prequisites for installing the RAD Toolkit for ASP.NET".
To install the RAD Toolkit for ASP .NET:

1. In your local environment, locate the installation file for the RAD Toolkit for ASP.NET software that
you downloaded from the Endeca Developer Network (EDeN).

2. Double click the appropriate installation file, and on the Welcome screen, click Next.

3. On the Select Installation Folder screen, either accept the default installation location, or click
Browse... and browse to the directory where you want to install. Endeca recommends that you
accept the default installation path of C:\Endeca\RADToolkits\<version>\ASP_NET.

4. On the Ready to Install screen, click Install.
5. Click Finish.

After performing this task, go on to "Adding the RAD Toolkit for ASP.NET to Visual Studio".

Adding the RAD Toolkit for ASP.NET to Visual Studio

This procedure adds the Endeca data source controls and Endeca user interface controls to the
Toolbox window of Visual Studio and also adds references from your Web site project to Endeca DLL
files.

>
7 Note: This procedure describes how to add the RAD Toolkit to Visual Studio 2005. The procedure
may be slightly different in Visual Studio 2008.

To add the RAD Toolkit for ASP.NET to Visual Studio:

Start Visual Studio and open your Web site.

In the Toolbox window, right-click the Standard tab and select Add Tab.

Type Endeca RAD Toolkit.

Right-click in the grey box under the entry for the RAD Toolkit.

Note: The grey box contains the text "There are no usable controls in this group..."

AP owbdPE

o

Select Choose Items...
6. Onthe .NET Framework Components tab of the Choose Toolbox Items dialog, click Browse....

7. Browse to <installation
path>\Endeca\RADToolkits\version\ASP _NET\bin\Endeca.Web._dIl and click Open.

8. Browse to <installation
path>\Endeca\RADToolkits\version\ASP _NET\bin\Endeca.Web.Ul .WebControls.dll
and click Open.

9. Click OK.

Endeca® RAD Toolkit for ASPNET Developer's Guide Endeca Confidential
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The Endeca data source controls and the Endeca user interface controls display in the Toolbox
under Endeca RAD Toolkit.

. In the Solution Explorer window, right-click your Web site.
. Select Add Reference....
. In the Add Reference dialog, select the Browse tab.

. Browse to the Endeca DLL files for the RAD Toolkit installation. In a default installation, these are
in <installation path>\Endeca\RADToolkits\version\ASP_NET\bin.

14. Select Endeca.Navigation.dll, Endeca.Navigation.AccessControl .dll,

Endeca.Data.dll, and Endeca.Logging.dll.You do not need to select Endeca.Web.dll

or Endeca.Web .Ul .WebControls.dll.

Visual Studio copies the directory's contents into the Web site project.

EREB

Uninstalling the RAD Toolkit for ASP.NET

This topic describes how to uninstall the Endeca RAD Toolkit from a system.
To uninstall the RAD Toolkit for ASP.NET:

From the Windows Control Panel, select Add or Remove Programs.

Select Endeca RAD Toolkit .NET from the list of installed software.

Click Remove and click Yes to confirm the removal.

Start Visual Studio and open your Web site.

In the Toolbox window, right-click the Endeca RAD Toolkit tab and select Delete Tab.

SAE I

Deploying the RAD Toolkit for ASP.NET reference
application

After connecting the reference application to an MDEX Engine, you can choose to run the application
in Postback mode, the URL mode, the RAD Toolkit Server Controls Postback mode, or the RAD Toolkit
Server Controls URL mode by clicking the corresponding link in the header of the reference application.

These instructions assume a typical system configuration that includes 1I1S 5.1, 1IS 6 Manager, and
the .NET Framework 2.0. There may be minor configuration differences if you are using other versions
of IS, IIS Manager, or the .NET Framework.

& . L.
7 Note: Make sure that you have enabled the ASP.NET 2.0 Web Service Extension in IIS before
deploying the reference application.

To deploy the RAD Toolkit for ASP.NET reference application:

1. From the Windows Control Panel, select Administrative Tools > Internet Information Services
(11S6) Manager.

2. Inthe IIS tree pane, expand the machine icon for the local machine, then expand the Web Sites
directory.

3. Right click the Default Web Site and select New > Virtual Directory....

%
Note: If you are using IIS 7, you should create an Application rather than a Virtual Directory.

Endeca Confidential Endeca® RAD Toolkit for ASPNET Developer's Guide
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9.

10.
n
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Complete the Virtual Directory Creation Wizard as follows:
a) Click Next.

b) Type an alias name such as RAD.

c) Click Next.

d) In the Web Site Content Directory screen, click Browse and locate the reference application
that is packaged with the RAD Toolkit for ASP.NET. Thisis in <installation
path>\Endeca\RADToolkits\version\ASP _NET\reference\RadAspNetRef.

e) Click Next.

f) Inthe Access Permissions window, leave the default settings in place.

g) Click Next, and then click Finish.

In the IIS tree pane, expand the machine icon and locate the virtual directory named RAD that you
created in the step above.

Right click RAD and select Properties.

. Select the Virtual Directory tab and perform the following tasks:

a) Under the Application Settings section, click Create.
b) From the Execute permissions list, select Scripts only.
c) Click Apply.

. Select the Documents tab and perform the following tasks:

a) Check Enable default content page.

b) Click Add....

c) In the Default content page field, type GuidedNavigation.aspx.

d) Click OK.

e) Select GuidedNavigation.aspx and click Move Up until the file is at the top position.

Select the ASP.NET tab and from the ASP.NET version list, select 2.0.x or later.
Click OK.

Restart IIS. (Right click the machine name icon in IIS. Select All Tasks from the submenu and
select Restart 11S.)

On your Windows machine, start Internet Explorer and navigate to
http://hostname/RAD/GuidedNavigation.aspx.

If you have an MDEX Engine running and want to view its records in the reference application,
provide the host and port information of the machine running an MDEX Engine and click Go.

Endeca® RAD Toolkit for ASPNET Developer's Guide Endeca Confidential



Chapter 2
Overview of the RAD Toolkit for ASP.NET

This section provides an overview of the RAD Toolkit for ASP.NET including its data source controls,
user interface controls, the reference application, and life cycle events.

Components in the RAD Toolkit for ASP.NET

The Rapid Application Development (RAD) Toolkit for ASP.NET provides a set of Web server controls
to build Endeca applications and also provides the RAD API to the Endeca MDEX Engine.

The RAD Toolkit for ASP.NET is made up of the following components:

* RAD API for ASPNET

A set of data source controls

« A set of user interface controls
« A reference application

e Documentation

The RAD API for ASP.NET to the Endeca MDEX Engine

The RAD API for ASP.NET provides a simplified interface to the Endeca MDEX Engine and makes
programming more friendly to the typical .NET developer.

Endeca assemblies

The RAD API is made up of the following assemblies:
« Endeca.Data.dll -- This is the RAD API itself. It is an abstraction of the Endeca Presentation
API that includes both input and output types and presents a standard interface for .NET developers.
« Endeca.Web.dll -- This contains the Endeca data source controls.
« Endeca.Web.Ul .WebControls.dlIl -- This contains the Endeca user interface controls and
Endeca Workbench instrumentation controls.

These assemblies must reside in your Web site project with Endeca.Navigation.dll,
Endeca.Navigation.AccessControl.dll, and Endeca.Logging.dll.
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Interaction of the RAD API for .NET and the Presentation API for .NET

Endeca is not yet deprecating the Presentation API for .NET or the Endeca Basic Development Guide
and Endeca Advanced Development Guide. Endeca is adding the RAD API for ASP.NET as a layer
on top of the Presentation API for .NET to make programming more friendly to the typical .NET
developer. This layer of abstraction provides a simplified interface. The RAD API for ASP.NET is
intended for use by all .NET customers.

The following diagram illustrates the interaction of the RAD API for .NET layer on top of the Presentation
API for .NET:

RAD AP| for NET

Client
t
Endeca Endece! reques
MDEX Presentation
APl

Engine  [(hr7p) for NET

Client
response
{HTTP})

Web browser

Class diagrams

The documentation includes two class diagrams that illustrate the input and output types of the RAD
API for .NET. These diagrams are <installation
path>\Endeca\RADToolkits\version\ASP _NET\doc\InputTypes.png and
OutputTypes.png.

Endeca data source controls

Endeca provides data source controls that are available from the Toolbox window of Visual Studio.
Each data source control provides design-time views of source data in the MDEX Engine. This data
can be bound to by other ASP.NET controls in your application.

5]
Note: Endeca data source controls are built as ASP.NET data source server controls. For
simplicity, this guide uses the more brief form of data source control.

The data source controls provide representative MDEX Engine data by performing round trip queries
to the MDEX Engine at design time.

You drag and drop any of following data source controls into your project and configure the data source
controls for your application:

Data source control Description

AggregateRecordDetailsDataSource | Provides details about a single aggregate record to other
controls in your Web site.

CompoundDimensionSearchDataSource | Provides records produced by compound dimension search
to other controls in your Web site.

DimensionSearchDataSource Provides results produced by dimension search to other
controls in your Web site.

MetadataDataSource Provides record metadata such as search keys, sort keys,
aggregation keys and so on.

NavigationDataSource Provides navigation query information, including dimension
refinements, record results, aggregated record results,

Endeca® RAD Toolkit for ASPNET Developer's Guide Endeca Confidential



Data source control

RecordDetailsDataSource

Overview of the RAD Toolkit for ASP.NET | Endeca user interface controls 15

Description

Analytics results, breadcrumbs information, metadata, and
supplemental objects.

Provides details (e.g. property values and dimension values)
about a single record to other controls in your Web site.

Endeca user interface controls

Endeca provides a number of custom user interface controls that are available from the Toolbox
window of Visual Studio. Each control provides a convenient user interface for common Endeca page

elements in an application.

b
Note: Endeca user interface controls are built as ASP.NET server controls. For simplicity, this
guide refers to them using the more brief form of user interface controls.

You drag and drop the following user interface controls into your project and configure them as
appropriate for your application.

Web server control

Breadcrumbs

GuidedNavigation

Pager

TagCloud

Description

Displays the search navigation descriptors for the current query.
Descriptors include dimension values, search terms, and range filters.
For example, a breadcrumb made up of dimension values might look
like this:

Wine Type > Red > Merlot > 1999 [X]

Renders dimension groups, dimensions, and dimension value names
on a Web page.

Displays paging choices to page through the record set, when the number
of search results are sufficient to create multiple pages. For example a
paging control typically looks like this:

<< <2, 3,4, 22>

Renders the most commonly used tags in records stored in an MDEX
Engine. Tags for frequently occurring query results display in a larger

font. Selecting a tag within a tag cloud produces a collection of query

results that are associated with that tag.

Endeca Workbench instrumentation controls

Endeca provides two instrumentation controls to help integrate a custom application into Endeca

Workbench.

%
Note: Endeca Workbench instrumentation controls are built as ASP.NET server controls. For
simplicity, this guide uses the more brief form of instrumentation controls.

Endeca Confidential
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You drag and drop the following instrumentation controls into any page that requires instrumentation
and configure the controls as appropriate for your application. See the Endeca Workbench
Administrator's Guide for more information about instrumenting an application.

Web server control Description

WebStudioNavigationinstrumentation Instruments a Web page to provide navigation state to
Endeca Workbench.

WebStudioRecordinstrumentation Instruments a Web page to provide record details state

to Endeca Workbench.

Reference application

The RAD Toolkit for ASP.NET provides a reference application that can be run in Postback mode,
URL mode, RAD Toolkit Server Controls Postback mode, or RAD Toolkit Server Controls URL mode.
Like other Endeca reference applications, the RAD Toolkit reference application provides a simple
front-end interface that allows you to connect to an MDEX Engine and examine a record set.

Installation locations

By default, the installer places the reference application in
C:\Endeca\RADToolkits\version\ASP.NET\reference\RadAspNetReT. This directory
includes the files for all modes of the reference application. The start page for the Postback mode is
GuidedNavigation.aspx. The start page for the URL parameter mode is
GuidedNavigationUrl .aspx.

Differences between the reference application modes

The Postback mode of the reference application uses HTTP POST requests, not HTTP GET requests
for each query in an application.

The URL parameter mode uses URL query parameters to generate an HTTP GET request for each
change in the navigation state. This means that any change to the navigation state (i.e. any search
or navigation request) is reflected in the URL itself and all information about the navigation state
displays in the URL.

Both modes of the reference application have a RAD Toolkit Server Controls mode. The RAD Toolkit
Server Controls modes use the Endeca user interface and data source controls that are included with
the RAD Toolkit for ASP.NET.

Deployment

You can deploy the reference application by following the instructions in "Deploying the RAD ASP.NET
reference application".

Page life cycle events for RAD Toolkit controls

First, by way of disclaimer, this topic does not go into detail about the core concepts of ASP.NET such
as general page life cycle stages or life cycle events for data bound controls. For background information
about page life cycle stages and page events, you can refer to the MSDN article titled "ASP.NET Page
Life Cycle Overview" at http://msdn2._.microsoft.com/en-us/library/ms178472.aspx.
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This topic assumes you have read the MSDN information and goes on to describe where the Endeca
data source controls plug into the ASP.NET page life cycle events.

RaisePostbackEvent

This is the first event in the life cycle that typically affects your page and the state of the queries on it.
All postback events such as button clicks and drop downs selected are handled at this stage. It is
common practice to programmatically update parameters on your data source in this event.

PreRender event

The Endeca data source controls perform a number of operations in the PreRender event of the page
event life cycle. The data source executes a query during this event only if another control on the page
requests data from the data source. When a control on the page is bound to a data source, it defines
a DataSourceView from which it gets its data. If the DataSourceView is not yet populated with
fresh data (based on the current filter set of the query), it calls ExecuteSelect to query the MDEX
Engine for fresh data.

Any control that is bound to an Endeca data source, for example, a Repeater control, a
GuidedNavigation control, and so on, also fetches its data during the PreRender page event.

Record class generation utility

The RAD Toolkit includes a utility for code-generating a strongly-typed record class.

The ASP_NET\bin\recgen.exe utility queries an MDEX Engine for records and creates a class
featuring the record’s properties as strongly typed members. If you provide the class's type name as
an argument to either the NavigationCommand . TypeNames.RecordTypeName or the Naviga-
tionDataSource.RecordTypeName property, the RAD Toolkit then serializes records into this
class instead of its default Endeca.Data.Record class.

Type recgen /7 atthe command line for more information.
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Chapter 3

Creating an application using Endeca server
controls

This section provides an overview of how to create an Endeca front-end application using the Endeca
data source controls and the Endeca user interface controls.

High level process of creating an application with server
controls

The basic workflow is as follows:

1.
2.

3.

4,
5.

Create (or open) your ASP.NET Web site in Visual Studio.

Add Endeca data source controls to the Web site so you can bind other controls to MDEX Engine
query results.

Add Endeca user interface controls to the Web site so you can provide search and navigation
features such as Guided Navigation controls, paging controls, breadcrumb controls, and so on.
Add other Visual Studio .NET controls to build search boxes, display record results, and so on.
Test and deploy your Web site.

Adding Endeca data source controls to a Web page

This section describes how to create and configure the Endeca data source controls available in the
RAD Toolkit for ASP.NET. Other ASP.NET controls can bind to the Endeca data source controls and
access Endeca query results.

On each data source, you can check the Preview Endeca data option to populate a control with
representative data from the MDEX Engine. This option gives you a design time view of the data that
the control provides to other controls on the page. If this option is unchecked, the user interface controls
populate themselves with placeholder data.

Creating a NavigationDataSource control

You create and configure a NavigationDataSource control in order to provide MDEX Engine records
to other controls in your Web site.
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In other words, the NavigationDataSource provides design time functionality to populate the other
controls (e.g. user interface controls) with all the properties in an Endeca record.

& " _ S .
77 Note: In addition to configuring the NavigationDataSource according to the procedure below,
you can also configure the NavigationDataSource using the Properties window of Visual Studio.

To create and configure an Endeca NavigationDataSource control:

Open your Web site in Visual Studio.
In the Toolbox window, expand the Endeca RAD Toolkit tab.
Drag the NavigationDataSource on to the Design tab of your Web page.

From the Smart Tag, check Preview Endeca data to populate other controls you add later with
representative data from the MDEX Engine.

From the Smart Tag, select Configure Data Source....
6. On the Choose Endeca server screen, do the following:

a) Specify the host and port on which the MDEX Engine is running. These are the only two required
values to finish the wizard. If you do not need any additional configuration, click Finish.
For example, the most basic configuration looks like this:

AP wbdpE

o

---------

b) If you are connecting to the MDEX Engine via SSL, click Browse... to locate the Web application's
private certificate file (typically a PEM file).
¢) Check Save server in web.config if you want the data source to refer to the web.config file
for host and port information. If unchecked, the host and port information is set as a property of
the data source.
d) If you checked Save server in web.config, specify the name of a server on which the file is
stored.
This option adds <configSections>, <expressionBuilders>, and <endeca> to your
web . config file as shown in this example:
<configuration>
<configSections>
<sectionGroup name="endeca"
type=""Endeca.Data.Configuration.EndecaSectionGroup,
Endeca.Data, Version=2.1.0.0, Culture=neutral,
Publ icKkeyToken=6d02be8724ca751c™ >
<section name="'servers"
type="Endeca.Data.Configuration.ServersSection,
Endeca.Data, Version=2.1.0.0, Culture=neutral,
PublickeyToken=6d02be8724ca751c" />
</sectionGroup>
</configSections>

<I-- (elements removed to show only what Endeca adds) -->
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<expressionBui lders>
<add expressionPrefix="EndecaConfig"
type=""Endeca.Web.Ul .Design.EndecaConfigurationExpression—-
Builder,
Endeca.Web, Version=2.1.0.0, Culture=neutral,
Publ ickeyToken=6d02be8724ca751c" />
</expressionBuilders>

<I-- (elements removed to show only what Endeca adds) -->

<endeca>
<servers>
<add name="MDEXServer' hostName="localhost"™ port="8000"
certificatePath="" />
</servers>
</endeca>
</configuration>

Furthermore, this option sets several property values in your ASPX file using ASP.NET
expressions, as shown in this example snippet:
<ccl:NavigationDataSource ID="NavigationDataSourcel™ runat="'server"

MdexCertificatePath="<%$ EndecaConfig:Servers.Servers["'MDEXServ-
er'].CertificatePath %>"

MdexHostName="<%$ EndecaConfig:Servers.Servers["MDEXServer'] .HostName
%>"

MdexPort="<%$ EndecaConfig:Servers.Servers["MDEXServer'].Port %>">
</ccl:NavigationDataSource>

7. At this point, you can either click Finish to finish configuring the data source, or you can click Next
to continue through the wizard and configure optional data source parameters and specify optional
Analytics query information. Adding data source parameters makes them available to other controls
on the page.

8. On the Edit data source parameters screen, do the following:

a) To add all parameters available to the NavigationDataSource control, click Add All Parameters.
These are all the parameters that can be passed to the MDEX Engine. An application will likely
only use a small number of these parameters; it is not required to include them all if not desired.

b) To add only specific parameters, you can add one parameter at a time. Click Add Parameter
and specify a name.

¢) To indicate where the value of a parameter comes from, select an option from the Parameter
source list.

d) To specify the value of a property, select the property and provide a value in DefaultValue.

e) If desired, you can use the Up, Down, and Delete buttons to change the display position of
parameters and delete parameters.

9. At this point, you can either click Finish to finish configuring the data source, or you can click Next
to continue through the wizard and specify optional Analytics query information. Adding an Analytics
guery makes the results of that query available to the data source and other controls on the page.

10. On the Configure analytics query screen, do the following:

a) Specify the syntax of one or more Analytics queries to run against the MDEX Engine.
Here is a simple example query that averages a property and groups the results by the
P_Winery property:

RETURN AvgPriceTable

AS SELECT AVG(@AvgPrice) AS AvgPrice
GROUP BY P_Winery
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b) If you want the data source to refer to the web.conFig file to read the Analytics query, check
Would you like to save this query in web.config? If unchecked, the Analytics query is set in
the AnalyticsExpression property of the data source.

c) If checked, specify a name for the Analytics query.
This option adds <queries> to your web.config file as shown in this example:

<queries>
<add name="QueryWithAveragePrice'>
<I[CDATA[RETURN AvgPriceTable AS SELECT AVG(@AvgPrice) AS AvgPrice

GROUP BY P_Winery]]>
</add>
</queries>

d) Click Next.

e) In the Analytics Parameter Values dialog box, specify a value for each parameter in the
Analytics query. Before submitting the Analytics query to the MDEX Engine, the data source
performs token replacement on the parameters using the values you specify.

For example, for the query above, you specify a value for the AvgPrice parameter. In this
example, the value is the P_Price property, which is determined at runtime.

11. On the Configure analytics result schema screen, do the following:

a) If necessary, modify the data type of each parameter and query result to correspond appropriately.
For example, if a query produces an AverageScore result with values such as 83.7500, 86.0000
and so on, you would change the default data type from String to Double. That way, the data
type of the parameter corresponds to its actual values.

This data type information is saved in the schema for the Analytics query.

b) If you want the data source to refer to the web . config file to reuse this schema, check Would
you like to save this schema in web.config? If unchecked, the schema information is set in
the AnalyticsSchema property of the data source.

This option adds <schemas> to your web . config file as shown in this example:

<schemas>
<add name="'SchemaQueryWithAverageScore">
<xs:schema i1d=""SchemaQueryWithAverageScore'" xmlns=""
xmIns:xs="http://www.w3.0rg/2001/XMLSchema"
xmlns:msdata=""urn:schemas-microsoft-com:xml-msdata'>
<xs:element name=""SchemaQueryWithAverageScore™ msdata:ls-
DataSet=""true"
msdata:Locale="en-US">
<xs:complexType>
<xs:choice minOccurs="0" maxOccurs="unbounded'>
<xs:element name=""AvgScoreTable" msdata:Locale="en-US">
<xs:complexType>
<XS:sequence>
<xs:element name=""P_Winery" type="'xs:string'" minOccurs="0"
/>
<xs:element name="AvgScore" type="'xs:double"™ minOccurs="0"
/>
</Xs:sequence>
</xs:complexType>
</xs:element>
</xs:choice>
</xs:complexType>
</xs:element>
</xs:schema>
</add>
</schemas>
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12. Click Finish.
13. In the Properties window of Visual Studio, modify the following properties for the data source

page

control if necessary. Many of these properties are set when you run the Configure Data Source...

wizard.
Property

AnalyticsExpressionParameters

MDEXCertificatePath

MDEXHostName

MDEXPort

RecordTypeName

SelectParameters

PermanentRefinementConfigs

AnalyticsExpression

AnalyticsSchema

BusinessRulesFilter

BusinessRulesPreviewTime

EnableComputeAlternativePhrasing

EnableDidYouMean

Endeca Confidential

Description

Optional. Invokes a wizard where you specify the
parameters used in an Analytics expression.

Optional. Specifies a path to the Web application's
private certificate file (typically a PEM file) if you are
connecting to the MDEX Engine via SSL.

Required. Specifies the host on which the MDEX Engine
is running.

Required. Specifies the port on which the MDEX Engine
is running.

Optional. Specifies a custom type for use by records
returned by this data source. The default value for
RecordTypeName is Endeca.Data.Record.

Optional. Specifies a collection of parameters to use
when the data source queries the MDEX Engine.

Optional. Specifies one or more dimensions, by ID, to
always expose and keep exposed on the page. A
dimension cannot be collapsed if a user clicks it. Click
the Browse... option to invoke the RefinementConfig
Collection Editor. This editor allows you to specify a
DimensionValueld for each dimension you want to
expose.

Optional. Specifies either the syntax of an Analytics
expression or specifies a property that points to the
expression in the web . conFig file. Typically, you create
an Analytics expression in the Configure analytics
query screen of the configuration wizard.

Optional. Specifies the attributes of the schema for the
AnalyticsExpression.

Optional. Specifies the filter that evaluates which
dynamic business rules the MDEX Engine runs.

Optional. Specifies the time used to determine whether
the MDEX Engine runs dynamic business rules that have
a time trigger.

Optional. Specifies whether the MDEX Engine should
compute alternative phrasings for the current record
search query. The default value for EnableComputeAl -
ternativePhrasingis False.

Optional. Specifies whether a full-text search should turn
on the Did You Mean? feature. Only used if a full-text
search query is being made. The default value for En-
ableDidYouMean is False.
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Property Description

EnableExposeAllRefinements Optional. Specifies whether to expose (open) all
dimensions on the page. Setting this property to True
exposes all dimensions.

EnableRewriteWithAlternativePhrasing Optional. Specifies whether the MDEX Engine uses one
of the alternative phrasings it has computed instead of
the end user's original query when computing the set of
documents to return. True instructs the MDEX Engine
to use a computed alternative phrasing, while False
(the default) instructs it to use the user's original query.
The EnableComputeAlternativePhrasing must
be set to True when using EnableRewriteWithAl-
ternativePhrasing.

RefinementConfigs Optional. Specifies one or more dimensions, by ID, to
initially expose (open) on the page. Unlike
PermanentRefinementConfigs, the dimensions you
specify for the RefinementConfigs property can be
collapsed if a user clicks them. Click the Browse... option
to invoke the RefinementConfig Collection Editor.
This editor allows you to specify a DimensionValueld
for each dimension you want to expose.

Note: This is not a comprehensive list of the properties available in the Properties window.
There may also be additional properties available to the control from the code behind (the
.aspx.cs file for the control) that do not display in the Properties window but are necessary
to fully configure the data source. For details about the properties for each data source control,
see the Endeca API Reference for the RAD Toolkit for ASP.NET.

NavigationDataSouce example code
The markup generated on the Source page of Visual Studio is similar to the following:

<ccl:NavigationDataSource ID="NavigationDataSourcel™ runat="server’ Mdex-
Port="7900"
MdexCertificatePath=""" MdexHostName="'smith-690"">
<PermanentRefinementConfigs>
<end:RefinementConfig DimensionValueld="3">
</end:RefinementConfig>
</PermanentRefinementConfigs>
</ccl:NavigationDataSource>

Creating a MetadataDataSource control

You create and configure a MetadataDataSource control in order to provide metadata such as the
available search keys, sort keys, aggregation keys, and so on, to other controls in your Web site. For
example, you might bind a drop-down list control to the available search keys from a
MetadataDataSource control.

When you create the control, the control looks up the metadata once and stores it but does not look
it up again unless you modify the caching properties.
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To create and configure an Endeca MetadataDataSource control:

Open your Web site in Visual Studio.

In the Toolbox window, expand the Endeca RAD Toolkit tab.

Drag the MetadataDataSource on to the Design tab of your Web page.
Select the MetadataDataSource and click the Smart Tag.

Check Preview Endeca data to populate other controls you add later with representative data from
the MDEX Engine

Select Configure Data Source....
. On the Choose Endeca server screen, do the following:

a) Specify the host and port on which the MDEX Engine is running. These are the only two required
values to finish the wizard. If you do not need any additional configuration, click Finish.
For example, the most basic configuration looks like this:
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b) If you are connecting to the MDEX Engine via SSL, click Browse... to locate the Web application's
private certificate file (typically a PEM file).

c) Check Save server in web.config if you want the MetadataDataSource to refer to the
web . confFig file for host and port information. If unchecked, the host and port information is
set as a property of the MetadataDataSource.

d) If you checked Save server in web.config, specify the name of the server on which the file is
stored.
This option adds <configSections>, <expressionBuilders>, and <endeca> to your
web . config file as shown in this example:

<configuration>

<configSections>
<sectionGroup name="endeca"
type="Endeca.Data.Configuration.EndecaSectionGroup,
Endeca.Data, Version=2.1.0.0, Culture=neutral,
Publ ickeyToken=6d02be8724ca751c" >
<section name="'servers"
type="Endeca.Data.Configuration.ServersSection,
Endeca.Data, Version=2.1.0.0, Culture=neutral,
Publ icKeyToken=6d02be8724ca751c" />
</sectionGroup>

</configSections>

<I-- (elements removed to show only what Endeca adds) -->

<expressionBui lders>
<add expressionPrefix="EndecaConfig"
type="Endeca.Web.Ul .Design.EndecaConfigurationExpression—-
Builder,
Endeca.Web, Version=2.1.0.0, Culture=neutral,
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Publ icKkeyToken=6d02be8724ca751c" />
</expressionBuilders>
<I-- (elements removed to show only what Endeca adds) -->
<endeca>
<servers>
<add name="MDEXServer' hostName="localhost"™ port="8000"
certificatePath=""" />
</servers>
</endeca>
</configuration>
Furthermore, this option sets several property values in your ASPX file using ASP.NET
expressions, as shown in this example snippet:
<ccl:MetadataDataSource ID="MetadataDataSourcel™ runat="'server’ Mdex-
Port="7900"
MdexCertificatePath="<%$ EndecaConfig:Servers.Servers[''MetadataDSCon—-
nection"].
CertificatePath %>
MdexHostName="<%$ EndecaConfig:Servers.Servers['MetadataDSConnec—
tion'].
HostName %>*
MdexPort="<%$ EndecaConfig:Servers.Servers['MetadataDSConnec—
tion'"].Port %>" />
</ccl:MetadataDataSource>
8. Click Finish.

9. In the Properties window of Visual Studio, modify the following properties for the
MetadataDataSource control if necessary:

Property Description

CacheDuration Optional. Specifies the length of time, in seconds, that data retrieved by
this data source is cached. The default value for CachingDuration is
0.

CacheExpirationPolicy Optional. Specifies the cache expiration behavior that, when combined
with the duration, describes the behavior of the cache that the data source
control uses. The default value for CacheExpirationPolicyis Shid-
ing.

CacheKeyDependency Optional. Specifies a user-defined key dependency that is linked to all
data items cached by this control. The default value is empty.

EnableCaching Optional. Specifies whether the data retrieved by this data source should
be fetched once and cached in the ASP.NET cache object rather than
fetched each time from the MDEX Engine. Settting this property to True
fetches the data once from the MDEX Engine and then stores that data
in the ASP.NET cache. Setting this value to Fal se fetches the data from
the MDEX Engine each time. The default value for EnableCaching is
False.

Note: This is not a comprehensive list of the properties available in the Properties window.
There may also be additional properties available to the control from the code behind (the
.aspx.cs file for the control) that do not display in the Properties window but are necessary
to fully configure the data source. For details about the properties for each data source control,
see the Endeca API Reference for the RAD Toolkit for ASP.NET.
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MetadataDataSource example code
The markup generated on the Source page of Visual Studio is similar to the following:

<ccl:MetadataDataSource ID="MetadataDataSourcel"™ runat="'server"
MdexCertificatePath="" />

Creating a DimensionSearchDataSource control

You create and configure a DimensionSearchDataSource control in order to provide results produced
by dimension search to other controls in your Web site.

To create and configure an Endeca DimensionSearchDataSource control:

Open your Web site in Visual Studio.
In the Toolbox window, expand the Endeca RAD Toolkit tab.
Drag the DimensionSearchDataSource on to the Design tab of your Web page.

From the Smart Tag, check Preview Endeca data to populate other controls you add later with
representative data from the MDEX Engine.

From the Smart Tag, select Configure Data Source....
6. On the Choose Endeca server screen, do the following:

a) Specify the host and port on which the MDEX Engine is running. These are the only two required
values to finish the wizard. If you do not need any additional configuration, click Finish.
For example, the most basic configuration looks like this:
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b) If you are connecting to the MDEX Engine via SSL, click Browse... to locate the Web application's
private certificate file (typically a PEM file).

c) Check Save server in web.config if you want the data source to refer to the web.config file
for host and port information. If unchecked, the host and port information is set as a property of
the data source.

d) If you checked Save server in web.config, specify the name of a server on which the file is
stored.

This option adds <configSections>, <expressionBuilders>, and <endeca> to your

web.config file as shown in this example:

<configuration>

<configSections>

<sectionGroup name="endeca"
type="Endeca.Data.Configuration.EndecaSectionGroup,
Endeca.Data, Version=2.1.0.0, Culture=neutral,
PublicKkeyToken=6d02be8724ca751c™ >
<section name="'servers"
type="Endeca.Data.Configuration.ServersSection,
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Endeca.Data, Version=2.1.0.0, Culture=neutral,
Publ icKkeyToken=6d02be8724ca751c" />
</sectionGroup>

</configSections>

<I-- (elements removed to show only what Endeca adds) -->

<expressionBui lders>
<add expressionPrefix="EndecaConfig"
type=""Endeca.Web.Ul .Design.EndecaConfigurationExpression—-
Builder,
Endeca.Web, Version=2.1.0.0, Culture=neutral,
Publ icKkeyToken=6d02be8724ca751c" />
</expressionBuilders>

<I-- (elements removed to show only what Endeca adds) -->

<endeca>
<servers>
<add name="MDEXServer' hostName="localhost"™ port="8000"
certificatePath="" />
</servers>
</endeca>
</configuration>

Furthermore, this option sets several property values in your ASPX file using ASP.NET
expressions, as shown in this example snippet:

<ccl:DimensionSearchDataSource ID="DimensionSearchDataSourcel
runat="'server"

MdexCertificatePath="<%$ EndecaConfig:Servers.Servers[''DSDSConnec-
tion'].

CertificatePath %>"

MdexHostName="<%$ EndecaConfig:Servers.Servers[''DSDSConnection’].Host-
Name %>"

MdexPort="<%$ EndecaConfig:Servers.Servers["DSDSConnection"].Port
0%>">
</ccl:DimensionSearchDataSource>

7. At this point, you can either click Finish to finish configuring the data source, or you can click Next
to continue through the wizard and configure optional data source parameters. Adding data source
parameters makes them available to other controls on the page.

8. On the Edit data source parameters screen, do the following:

a) To add all parameters available to the data source control, click Add All Parameters. These
are all the parameters that can be passed to the MDEX Engine. An application will likely only
use a small number of these parameters; it is not required to include them all if not desired.

b) To add only specific parameters, you can add one parameter at a time. Click Add Parameter
and specify a name.

¢) To indicate where the value of a parameter comes from, select an option from the Parameter
source list.

d) To specify the value of a property, select the property and provide a value in DefaultValue.

e) If desired, you can use the Up, Down, and Delete buttons to change the display position of
parameters and delete parameters.

9. Click Finish.

10. In the Properties window of Visual Studio, modify the following properties for the data source
control if necessary. Many of these properties are set when you run the Configure Data Source...
wizard.
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Property

MDEXCertificatePath

MDEXHostName

MDEXPort

SelectParameters

DimensionValuesPerDimension

EqlExpression

RecordFilter
SearchMode

SearchTerms

e

page

Description

Optional. Specifies a path to the Web application's private
certificate file (typically a PEM file) if you are connecting to the
MDEX Engine via SSL.

Required. Specifies the host on which the MDEX Engine is
running.

Required. Specifies the port on which the MDEX Engine is
running.

Optional. Specifies a collection of parameters to use when the
data source queries the MDEX Engine.

Optional. Specifies the number of results to return for the
dimension search.

Optional. Specifies the Endeca Query Language expression for
the dimension search.

Optional. Specifies the record filter for the dimension search.

Specifies a search mode for each dimension search operation
in a query. Valid search modes are the following: All, AllAny,
AllPartial, Any, Boolean, Partial, PartialMax. See "Valid search
modes" in the Endeca Basic Development Guide for a definition
of each mode.

Required. Specifies the search terms for the dimension search.

Note: This is not a comprehensive list of the properties available in the Properties window.

There may also be additional properties available to the control from the code behind (the
.aspx.cs file for the control) that do not display in the Properties window but are necessary
to fully configure the data source. For details about the properties for each data source control,
see the Endeca API Reference for the RAD Toolkit for ASP.NET.

DimensionSearchDataSouce example code
The markup generated on the Source page of Visual Studio is similar to the following:

<ccl:DimensionSearchDataSource ID=""DimensionSearchDataSourcel™
runat=""server" MdexPort=""7900"

MdexCertificatePath=""" MdexHostName="'smith-690"">
</ccl:DimensionSearchDataSource>

Creating a CompoundDimensionSearchDataSource control

You create and configure a CompoundDimensionSearchDataSource control in order to provide
results produced by compound dimension search to other controls in your Web site.

To create and configure an Endeca CompoundDimensionSearchDataSource control:

1. Open your Web site in Visual Studio.
2. In the Toolbox window, expand the Endeca RAD Toolkit tab.
3. Drag the CompoundDimensionSearchDataSource on to the Design tab of your Web page.
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4. From the Smart Tag, check Preview Endeca data to populate other controls you add later with
representative data from the MDEX Engine.

5. From the Smart Tag, select Configure Data Source....
6. On the Choose Endeca server screen, do the following:

a) Specify the host and port on which the MDEX Engine is running. These are the only two required
values to finish the wizard. If you do not need any additional configuration, click Finish.
For example, the most basic configuration looks like this:

---------

b) If you are connecting to the MDEX Engine via SSL, click Browse... to locate the Web application's
private certificate file (typically a PEM file).

¢) Check Save server in web.config if you want the data source to refer to the web . config file
for host and port information. If unchecked, the host and port information is set as a property of
the data source.

d) If you checked Save server in web.config, specify the name of a server on which the file is
stored.
This option adds <configSections>, <expressionBuilders>, and <endeca> to your
web.config file as shown in this example:

<configuration>

<configSections>
<sectionGroup hame="endeca"
type="Endeca.Data.Configuration.EndecaSectionGroup,
Endeca.Data, Version=2.1.0.0, Culture=neutral,
Publ ickeyToken=6d02be8724ca751c" >
<section name="servers"
type="Endeca.Data.Configuration.ServersSection,
Endeca.Data, Version=2.1.0.0, Culture=neutral,
PublicKkeyToken=6d02be8724ca751c" />
</sectionGroup>

</configSections>

<I-- (elements removed to show only what Endeca adds) -->

<expressionBui lders>
<add expressionPrefix="EndecaConfig"
type="Endeca.Web.Ul .Design.EndecaConfigurationExpression-
Builder,
Endeca.Web, Version=2.1.0.0, Culture=neutral,
Publ icKkeyToken=6d02be8724ca751c" />
</expressionBuilders>

<I-- (elements removed to show only what Endeca adds) -->
<endeca>

<servers>
<add name="MDEXServer'" hostName="localhost" port="8000"
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certificatePath=""" />
</servers>
</endeca>
</configuration>

Furthermore, this option sets several property values in your ASPX file using ASP.NET
expressions, as shown in this example snippet:
<ccl:CompoundDimensionSearchDataSource ID=""CompoundDimensionSearchData-
Sourcel™

runat="'server"

MdexCertificatePath="<%$ EndecaConfig:Servers.Servers["CmpdDim-
Search'] .CertificatePath %>

MdexHostName="<%$ EndecaConfig:Servers.Servers[''CmpdDimSearch'].Host—
Name %>"

MdexPort="<%$ EndecaConfig:Servers.Servers["CmpdDimSearch'"].Port
0®w>">
</ccl:CompoundDimensionSearchDataSource>

7. At this point, you can either click Finish to finish configuring the data source, or you can click Next
to continue through the wizard and configure optional data source parameters. Adding data source
parameters makes them available to other controls on the page.

8. On the Edit data source parameters screen, do the following:

a) To add all parameters available to the data source control, click Add All Parameters. These
are all the parameters that can be passed to the MDEX Engine. An application will likely only
use a small number of these parameters; it is not required to include them all if not desired.

b) To add only specific parameters, you can add one parameter at a time. Click Add Parameter
and specify a name.

¢) To indicate where the value of a parameter comes from, select an option from the Parameter
source list.

d) To specify the value of a property, select the property and provide a value in DefaultValue.

e) If desired, you can use the Up, Down, and Delete buttons to change the display position of
parameters and delete parameters.

9. Click Finish.

10. In the Properties window of Visual Studio, modify the following properties for the data source
control if necessary. Many of these properties are set when you run the Configure Data Source...

wizard.
Property Description
MDEXCertificatePath Optional. Specifies a path to the Web application's private
certificate file (typically a PEM file) if you are connecting to the
MDEX Engine via SSL.
MDEXHostName Required. Specifies the host on which the MDEX Engine is
running.
MDEXPort Required. Specifies the port on which the MDEX Engine is
running.
SelectParameters Optional. Specifies a collection of parameters to use when the

data source queries the MDEX Engine.

DimensionValuesPerDimension Optional. Specifies the number of results to return for the
compound dimension search.

EqglExpression Optional. Specifies the Endeca Query Language expression for
the compound dimension search.
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Property Description

RecordFilter Optional. Specifies the record filter for the compound dimension
search.

SearchMode Optional. Specifies a search mode for each compound dimension
search operation in a query. Valid search modes are the
following: All, AllAny, AllPartial, Any, Boolean, Partial, PartialMax.
See "Valid search modes" in the Endeca Basic Development
Guide for a definition of each mode.

SearchTerms Required. Specifies the search terms for the dimension search.

4 Note: This is not a comprehensive list of the properties available in the Properties window.
There may also be additional properties available to the control from the code behind (the
.aspx.cs file for the control) that do not display in the Properties window but are necessary
to fully configure the data source. For details about the properties for each data source control,
see the Endeca API Reference for the RAD Toolkit for ASP.NET.

CompoundDimensionSearchDataSouce example code
The markup generated on the Source page of Visual Studio is similar to the following:

<ccl:CompoundDimensionSearchDataSource ID="CompoundDimensionSearchData-
Sourcel" runat="'server"

MdexCertificatePath="<%$ EndecaConfig:Servers.Servers[' ' CmpdDim-
Search] .CertificatePath %>"

MdexHostName="<%$ EndecaConfig:Servers.Servers["'CmpdDimSearch'].HostName
%>"

MdexPort="<%$ EndecaConfig:Servers.Servers["CmpdDimSearch'].Port %>">
</ccl:CompoundDimensionSearchDataSource>

Creating a RecordDetailsDataSource control

You create and configure a RecordDetailsDataSource control in order to provide record detail
information (property values and dimension values) about a single record to other controls in your
Web site.

To create and configure an Endeca RecordDetailsDataSource control:

Open your Web site in Visual Studio.
In the Toolbox window, expand the Endeca RAD Toolkit tab.
Drag the RecordDetailsDataSource on to the Design tab of your Web page.

From the Smart Tag, check Preview Endeca data to populate other controls you add later with
representative data from the MDEX Engine.

From the Smart Tag, select Configure Data Source....
6. On the Choose Endeca server screen, do the following:

a) Specify the host and port on which the MDEX Engine is running. These are the only two required
values to finish the wizard. If you do not need any additional configuration, click Finish.
For example, the most basic configuration looks like this:

oD PR
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b) If you are connecting to the MDEX Engine via SSL, click Browse... to locate the Web application's
private certificate file (typically a PEM file).

c) Check Save server in web.config if you want the data source to refer to the web.config file
for host and port information. If unchecked, the host and port information is set as a property of
the data source.

d) If you checked Save server in web.config, specify the name of a server on which the file is
stored.
This option adds <configSections>, <expressionBuilders>, and <endeca> to your
web . config file as shown in this example:

<configuration>

<configSections>
<sectionGroup name="endeca"
type="Endeca.Data.Configuration.EndecaSectionGroup,
Endeca.Data, Version=2.1.0.0, Culture=neutral,
Publ ickeyToken=6d02be8724ca751c" >
<section name="'servers"
type="Endeca.Data.Configuration.ServersSection,
Endeca.Data, Version=2.1.0.0, Culture=neutral,
Publ icKeyToken=6d02be8724ca751c" />
</sectionGroup>

</configSections>

<I-- ___(elements removed to show only what Endeca adds)... -->

<expressionBui lders>
<add expressionPrefix="EndecaConfig"
type="Endeca.Web.Ul .Design.EndecaConfigurationExpression—-
Builder,
Endeca.Web, Version=2.1.0.0, Culture=neutral,
Publ ickeyToken=6d02be8724ca751c" />
</expressionBuilders>

<I-—- ___(elements removed to show only what Endeca adds)... -->

<endeca>
<servers>
<add name="MDEXServer' hostName="localhost"™ port="8000"
certificatePath=""" />
</servers>
</endeca>
</configuration>

Furthermore, this option sets several property values in your ASPX file using ASP.NET
expressions, as shown in this example snippet of a NavigationDataSource control:

<ccl:RecordDetai IsDataSource ID=""RecordDetailsDataSourcel™
runat=""server" MdexCertificatePath="<%$
EndecaConfig:Servers.Servers[''RDDSConnection'] .CertificatePath %>"
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MdexHostName="<%$ EndecaConfig:Servers.Servers[''RDDSConnection’].Host-
Name %>

MdexPort="<%$ EndecaConfig:Servers.Servers["'RDDSConnection'].Port
%w>">
</ccl:RecordDetai IsDataSource>

7. At this point, you can either click Finish to finish configuring the data source, or you can click Next
to continue through the wizard and configure optional data source parameters. Adding data source
parameters makes them available to other controls on the page.

8. On the Edit data source parameters screen, do the following:

a) To add all parameters available to the data source control, click Add All Parameters. These
are all the parameters that can be passed to the MDEX Engine. An application will likely only
use a small number of these parameters; it is not required to include them all if not desired.

b) To add only specific parameters, you can add one parameter at a time. Click Add Parameter
and specify a name.

¢) To indicate where the value of a parameter comes from, select an option from the Parameter
source list.

d) To specify the value of a property, select the property and provide a value in DefaultValue.

e) If desired, you can use the Up, Down, and Delete buttons to change the display position of
parameters and delete parameters.

9. Click Finish.

10. In the Properties window of Visual Studio, modify the following properties for the data source
control if necessary. Many of these properties are set when you run the Configure Data Source

... Wizard.

Property Description

MDEXCertificatePath Optional. Specifies a path to the Web application's private certificate
file (typically a PEM file) if you are connecting to the MDEX Engine
via SSL.

MDEXHostName Required. Specifies the host on which the MDEX Engine is running.

MDEXPort Required. Specifies the port on which the MDEX Engine is running.

SelectParameters Optional. Specifies a collection of parameters to use when the data
source queries the MDEX Engine.

Identifier Required. Specifies the identifier for a record whose details you

want to display.

Note: This is not a comprehensive list of the properties available in the Properties window.
There may also be additional properties available to the control from the code behind (the
.aspx.cs file for the control) that do not display in the Properties window but are necessary
to fully configure the data source. For details about the properties for each data source control,
see the Endeca API Reference for the RAD Toolkit for ASP.NET.

RecordDetailsDataSouce example code

The markup generated on the Source page of Visual Studio is similar to the following snippet. This
example sets the Identifier when a user clicks a record in a ListBox control.

<ccl:RecordDetai lsDataSource ID="RecordDetailsDataSourcel" runat="server"
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MdexHostName=""smith-690"">
<SelectParameters>
<asp:ControlParameter ControlID="LinkButtonl' Name="ldentifier"
PropertyName="Text" />
</SelectParameters>
</ccl:RecordDetai lsDataSource>

Creating an AggregateRecordDetailsDataSource control

You create and configure an AggregateRecordDetailsDataSource control in order to provide details
about a single aggregate record to other controls in your Web site.

You specify an AggregationKey property and any other properties necessary to describe the set of
aggregate records to return from the MDEX Engine. These properties may include SelectedDimen-
sionValuelds, EqlExpression, RecordFi lter, and so on. Together these properties build up
the navigation state of an aggregate record query submitted to the MDEX Engine.

The MDEX Engine returns an aggregate record in an AggregateRecordsResult object. The Ag-
gregateRecordsResul t object contains the AggregateRecord object, which contains a collection
of Record objects and the properties and dimensions of a single representative record.

To create and configure an Endeca AggregateRecordDetailsDataSource control:

1. Open your Web site in Visual Studio.

2. In the Toolbox window, expand the Endeca RAD Toolkit tab.

3. Drag the AggregateRecordDetailsDataSource on to the Design tab of your Web page.
4

. From the Smart Tag, check Preview Endeca data to populate other controls you add later with
representative data from the MDEX Engine

From the Smart Tag, select Configure Data Source....
. On the Choose Endeca server screen, do the following:

a) Specify the host and port on which the MDEX Engine is running. These are the only two required
values to finish the wizard. If you do not need any additional configuration, click Finish.
For example, the most basic configuration looks like this:

o o

---------

b) If you are connecting to the MDEX Engine via SSL, click Browse... to locate the Web application's
private certificate file (typically a PEM file).

¢) Check Save server in web.config if you want the data source to refer to the web . config file
for host and port information. If unchecked, the host and port information is set as a property of
the data source.

d) If you checked Save server in web.config, specify the name of a server on which the file is
stored.
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This option adds <configSections>, <expressionBuilders>, and <endeca> to your
web . config file as shown in this example:

<configuration>

<configSections>
<sectionGroup name="endeca"
type="Endeca.Data.Configuration.EndecaSectionGroup,
Endeca.Data, Version=2.1.0.0, Culture=neutral,
Publ icKeyToken=6d02be8724ca751c™ >
<section name="servers"
type=""Endeca.Data.Configuration.ServersSection,
Endeca.Data, Version=2.1.0.0, Culture=neutral,
Publ ickeyToken=6d02be8724ca751c" />
</sectionGroup>

</configSections>

<I-—- ___(elements removed to show only what Endeca adds)... -->

<expressionBui lders>
<add expressionPrefix="EndecaConfig"
type="Endeca.Web.Ul .Design.EndecaConfigurationExpression-
Builder,
Endeca.Web, Version=2.1.0.0, Culture=neutral,
PublickeyToken=6d02be8724ca751c" />
</expressionBuilders>

<l-- ___(elements removed to show only what Endeca adds)... -->

<endeca>
<servers>
<add name="MDEXServer'" hostName="localhost" port="8000"
certificatePath="" />
</servers>
</endeca>
</configuration>

Furthermore, this option sets several property values in your ASPX file using ASP.NET
expressions, as shown in this example snippet:

<ccl:AggregateRecordDetai lsDataSource ID=""AggregateRecordDetai lsData-
Sourcel™

runat="'server"

MdexCertificatePath="<%$ EndecaConfig:Servers.Servers[''AGRDSConnec-
tion™].

CertificatePath %>"

MdexHostName="<%$ EndecaConfig:Servers.Servers[""AGRDSConnec—
tion'] .HostName %>"

MdexPort="<%$ EndecaConfig:Servers.Servers["AGRDSConnection'].Port
%>">
</ccl:AggregateRecordDetai lsDataSource>

7. At this point, you can either click Finish to finish configuring the data source, or you can click Next
to continue through the wizard and configure optional data source parameters. Adding data source
parameters makes them available to other controls on the page.

8. On the Edit data source parameters screen, do the following:

a) To add all parameters available to the data source control, click Add All Parameters. These
are all the parameters that can be passed to the MDEX Engine. An application will likely only
use a small number of these parameters; it is not required to include them all if not desired.
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b) To add only specific parameters, you can add one parameter at a time. Click Add Parameter

and specify a name.

¢) To indicate where the value of a parameter comes from, select an option from the Parameter

source list.

d) To specify the value of a property, select the property and provide a value in DefaultValue.
e) If desired, you can use the Up, Down, and Delete buttons to change the display position of
parameters and delete parameters.

9. Click Finish.

10. In the Properties window of Visual Studio, modify the following properties for the data source control
if necessary. Many of these properties are set when you run the Configure Data Source... wizard.

Property
AggregationKey

EqlExpression
Identifier
RecordFilter

MDEXCertificatePath

MDEXHostName
MDEXPort

SelectParameters

Description

Required. Specifies the property or dimension by which records
should be aggregated.

Optional. Specifies the Endeca Query Language expression for the
aggregate record's record list.

Required. Specifies the identifier for an aggregate record whose
details you want to display.

Optional. Specifies the record filter for the aggregate record list.

Optional. Specifies a path to the Web application's private certificate
file (typically a PEM file) if you are connecting to the MDEX Engine
via SSL.

Required. Specifies the host on which the MDEX Engine is running.
Required. Specifies the port on which the MDEX Engine is running.

Optional. Specifies a collection of parameters to use when the data
source queries the MDEX Engine.

Note: This is not a comprehensive list of the properties available in the Properties window.

There may also be additional properties available to the control from the code behind (the
.aspx.cs file for the control) that do not display in the Properties window but are necessary
to fully configure the data source. For details about the properties for each data source control,
see the Endeca API Reference for the RAD Toolkit for ASP.NET.

runat=""'server"

AggregateRecordDetailsDataSouce example code
The markup generated on the Source page of Visual is similar to the following snippet:
<ccl:AggregateRecordDetai lsDataSource ID=""RecordDetailsDataSourcel™

MdexHostName=""smith-690"">
</ccl:AggregateRecordDetai lsDataSource>

Refreshing a data source control

If you update the records in the MDEX Engine, you can refresh the data source connection to pick up

the updates.

To refresh an Endeca data source control:
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1. Select the Endeca data source and click the Smart Tag.

2.

Click Refresh Schema.

Working with Endeca user interface controls

This section describes how to create and configure the Endeca user interface controls (Breadcrumbs,
GuidedNavigation, Pager, and TagCloud) available in the RAD Toolkit for ASP.NET.

Creating a GuidedNavigation control

You create and configure a GuidedNavigation control in order to render dimension groups, dimensions,
and dimension values on a Web page.

You must have created a NavigationDataSource control before performing this task.

To create a GuidedNavigation control:

apr wbd PR

Open your Web site in Visual Studio.

In the Toolbox window, expand the Endeca RAD Toolkit tab.

Drag the GuidedNavigation control on to the Design tab of your Web page.
Select the GuidedNavigation control and click the Smart Tag.

From the Choose Data Source list, select a NavigationDataSource control.
If you checked Preview Endeca Data on the NavigationDataSource, then the GuidedNavigation
control displays actual dimension and dimension value names rather than the placeholder names.

In the Properties window of Visual Studio, modify the following properties for the GuidedNavigation

control:
Property

DataMember

UrlManagerld

ExclusionDimensionlds

InclusionDimensionlds

ShowlmplicitDimensionValues

Description

Required. This is set to DimensionStatesResult and is not
available to modify.

Optional. Specifies the name of the Ur IManager that builds
URLs for the control.

Optional. Excludes the dimension values you specify by ID and
displays all other dimension values. Do not use this property in
conjunction with the InclusionDimensionlds property; use
one or the other but not both. By default, the GuidedNavigation
control includes all dimensions for display.

Optional. Displays only the dimension values you specify by ID
and no other dimension values. Do not use this property in
conjunction with the ExclusionDimensionlds property; use
one or the other but not both. By default, the GuidedNavigation
control includes all dimensions for display.

Optional. Specifies whether any implicit dimension values display
in the control. Choosing True displays implicit dimensions. See
the Endeca Basic Development Guide for more information
about implicit dimensions. The default value for ShowImplic-
itDimensionValues is False.
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Property Description

ShowRefinements Optional. Specifies whether any dimension values display in the
control. Choosing False means the control does not display
any dimension values. The default value for ShowRefinements
is True.

ShowSelectedDimensionValues Optional. Specifies whether a selected dimension value displays
in the control. Choosing True displays the selected dimension
values along with an [X] next to the value and also closes the
parent dimension. Clicking the [X] removes the dimension value
from the query. (This removal feature is essentially an inline
breadcrumb for the GuidedNavigation control.) Choosing
False does not display the selected dimension value in the
control. The default value for is False.

GuidedNavigation example code
The markup generated on the Source page is similar to the following:

<cc2:GuidedNavigation ID="GuidedNavigationl" runat="'server"
DataSourcelD="NavigationDataSourcel" ShowRefinements="True'>
</cc2:GuidedNavigation>

Here is an example GuidedNavigation control as rendered on a Web page:

Wine Type
Region
vintaje

DesigndUon
Characteristics
Dody

Flavors
Drinlcakility

GuidedNavigation control templates

The GuidedNavigation control supports several templates that allow you to modify the default
presentation of the control. Each template in the control has default markup that is part of the Ende-
ca.Web_Ul _.WebControls assembly. You can over ride the default presentation as necessary by
providing your own markup in the templates.

Template name Description

DimensionStateGroupTem- This template defines how dimension groups display. The default
plate markup for the template is:

<DimensionStateGroupTemplate>
<div class="DimensionGroupName">
<%# Eval('Name') %>
</div>
</DimensionStateGroupTemplate>
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Template name

DimensionStateTemplate

RefinementDimensionVal-
ueTemplate

SelectedDimensionValueTem-
plate

ImplicitDimensionValueTem—
plate

ShowMoreDimensionValuesTem-
plate

Description

This template defines how dimensions display. The default markup
for the template is:

<DimensionStateTemplate>
<asp:LinkButton runat="server' Command-
Name=""ToggleDimensionStateExposure"
Visible="<%# Eval('IsRefinable') %>">
<%# Eval('Dimension.DisplayName') %>
</asp:LinkButton>
<asp:Label runat="server™ Visible="<\#
I'(bool)Eval (""IsRefinable'™) %>">
<%# Eval(‘'Dimension.DisplayName'™) %>
</asp:Label>
</DimensionStateTemplate>

This template defines how dimension values display. The default
markup for the template is:

<RefinementDimensionValueTemplate>
<asp:LinkButton runat="server’ CommandName='"Se-
lectDimensionValue'>
<%# Eval(‘'DisplayName') %>
</asp:LinkButton><asp:Label runat="server"
class=""RecordCount"
Visible="<%# Container.Dataltem.Record-
Count.HasValue %>">
(<%# Eval ("'RecordCount') %>)
</asp:Label>
</RefinementDimensionValueTemplate>

This template defines how selected dimension values display.
The default markup for the template is:

<SelectedDimensionValueTemplate>

<asp:Label runat="server'><%# Eval('Display-
Name') %></asp:Label>

<asp:LinkButton runat="server' CommandName=''Re-
moveDimensionValue'>[x]</asp:LinkButton>
</SelectedDimensionValueTemplate>

This template defines how implicit dimension values display (if
they are enabled for display). The default markup for the template
is:

<ImplicitDimensionValueTemplate>

<asp:Label runat="server"><W# Eval("'Display-
Name') %></asp:Label>
</ImplicitDimensionValueTemplate>

This template defines how the default More... link displays when
additional dimension values can be selected. The default markup
for the template is:

<ShowMoreDimensionValuesTemplate>
<asp:LinkButton runat="'server' Command-

Name=""ShowMore " >More. . .</asp:LinkButton>

</ShowMoreDimensionValuesTemplate>

Endeca® RAD Toolkit for ASPNET Developer's Guide Endeca Confidential



Creating an application using Endeca server controls | Working with Endeca user interface controls 41

Creating a Breadcrumbs control

You create and configure a Breadcrumbs control in order to display the search and navigation
descriptors for a query. Descriptors include dimension value paths (including inert dimensions), search
terms, and range filters.

You must have created a NavigationDataSource control before performing this task.

The Breadcrumbs control supports two modes to render bread crumbs -- standard mode and alternate
mode. Standard mode separates search and navigation descriptors with the > sign, and you remove
all search and navigation descriptors (the full path) by clicking the Remove link in a breadcrumb.

In alternate mode, each search and navigation descriptor after the root dimension is separated by an
X (the separator is configurable as text or an image of your choice), and you remove search and
navigation descriptors by clicking the X for a particular search or navigation descriptor in a query. For
example, in a breadcrumb such as Wine Type > Red (X) > Merlot (X), you click X to delete
one navigation descriptor at a time.

To create a Breadcrumbs control:

Open your Web site in Visual Studio.

In the Toolbox window, expand the Endeca RAD Toolkit tab.

Drag the Breadcrumbs control on to the Design tab of your Web page.

Select the Breadcrumbs control and click the Smart Tag.

From the Choose Data Source list, select an NavigationDataSource on the page.

You can run the Configure Data Source wizard to modify the data source you selected above.
This step is typically unnecessary.

7. In the Properties window of Visual Studio, modify the following properties for the Breadcrumbs
control:

Property Description

ok wdhPRE

DataMember Required. This is set to AppliedFiltersRe-
sult and cannot be modified.

UrlManagerld Optional. Specifies the name of the Ur IManager
that builds URLSs for the control.

Title Optional. Specifies a title for the control if
breadcrumbs exist. If there are no breadcrumbs
to display the value of TitleWhenEmpty displays.
The default value for Title is an empty string.

TitleWhenEmpty Optional. Specifies a title for the control to display
if breadcrumbs do not exist. The default value for
TitleWhenEmpty is an empty string.

ExclusionDimensionlds Optional. Excludes the dimension values you
specify by ID and displays all other dimension
values in a breadcrumb. Do not use this property
in conjunction with the InclusionDimension-
1ds property; use one or the other but not both.
By default, the Breadcrumbs control includes all
dimensions for display in a breadcrumb path.

InclusionDimensionlds Optional. Displays only the dimension values you
specify by ID and no other dimension values in a
breadcrumb. Dimension values display in the
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Property

SuggestedSearchAdjustmentCaption

RemovelmageUrl

RemoveLinkText

Separator

ShowsSelectedDimensionValues

ShowFullylnertSelectedDimensionValues

ShowpPartiallylnertSelectedDimensionValues

Endeca® RAD Toolkit for ASPNET Developer's Guide

Description

breadcrumb in the same order you specify them
in the array. Do not use this property in conjunction
with the ExclusionDimensionlds property;
use one or the other but not both. By default, the
Breadcrumbs control includes all dimensions for
display.

Optional. Specifies text that precedes the list of
Did You Mean options (i.e. search adjustments).

Optional. Use only if UseAl ternateRendering
is set to True. Browse to an image file you want
the user to click to remove a breadcrumb. If you
specify RemovelmageUrl and RemoveLinkText,
the image takes precedence over the link text.

Optional. Use only if UseAl ternateRendering
is set to True. Specify text that you want to use
to for the link to remove a breadcrumb. (This is
often simply an X.)

Optional. Specifies what separator to use between
navigation descriptors in the control. The default
value for Separator is the > sign.

Optional. Specifies whether dimension values
display in breadcrumbs. True enables display
and False disables display. The default value for
ShowSelectedDimensionValues is True. If
this is Fal se the ShowFullylnertDimensions
and ShowPartiallylnertDimensions settings do

not apply.

Optional. Specifies whether inert dimensions
display in breadcrumbs. A fully inert dimension
shows every dimension value selected as part of
the breadcrumb. (Typically clicking on an inert
dimension changes the dimension tree but does
not change record results. Therefore inert
dimensions usually do not appear in breadcrumbs.
However, there may be cases where you want to
set ShowFul lylnertSelectedDimensionVa-
lues to True to show each inert dimension
selected in a breadcrumb trail.) The default value
for ShowFul lyInertSelectedDimensionVa-
luesis True.

Optional. Specifies whether inert dimensions
display in breadcrumbs. A partially inert dimension
shows only the leaf dimension value in the
breadcrumb rather than the entire path to the leaf.
In other words, the first dimensions in the path are
normal dimensions and the leaf dimension is inert.
The default value for ShowPartial lylnertSe-
lectedDimensionValues is True.
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Property Description

ShowRangeFilters Optional. Specifies whether range filters display
in breadcrumbs. True enables display and Fal se
disables display. The default value for
ShowRangeFilters is True.

ShowSearches Optional. Specifies whether the search terms in a
query display in breadcrumbs. True enables
display and False disables display. The default
value for ShowSearches is True.

UseAlternateRendering Optional. Specifies whether to use standard mode
breadcrumbs or alternate mode breadcrumbs.
True enables alternate mode. If you set this to
True, you can also specify a value for Re-
move ImageUrl or RemoveL inkText. If you
specify neither property, the default separator for
alternate rendering is an X. The default value for
UseAlternateRendering is False.

Breadcrumbs example code
The markup generated on the Source page is similar to the following

<cc2:Breadcrumbs ID="Breadcrumbsl™ runat="'server' DataSourcelD=""Navigation—-
DataSourcel™

RemovelmageUrl="~/Resources/x.gif" UseAlternateRendering="True">
</cc2:Breadcrumbs>

When navigating the sample wine data set, the control in the above example renders on a Web page
like this:

Refinement: Region > Bordeaux @
Refinement: Price Range > 530 to $40 &

Breadcrumbs control templates

The Breadcrumbs control supports several templates that allow you to modify the default presentation
of the control. Each template in the control has default markup that is part of the Endeca.Web .Ul _We-
bControls assembly. You can over ride the default presentation as necessary by providing your own
markup in the templates.

Template name Description

FirstDimensionValueTem- This template defines how the first dimension value in a breadcrumb
plate displays. The formatting you specify applies only to the first dimension
in the breadcrumb path. The default markup for the template is:
<FirstDimensionValueTemplate>
<asp:Button runat="'server' Text="'Remove"
CommandName=""RemoveDimensionValue" />
<%# Eval('DisplayName'™) %>
</FirstDimensionValueTemplate>
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Template name

IntermediateDimensionVa-
lueTemplate

LastDimensionValueTem-
plate

RangeBreadcrumbTemplate

Description

For example:

<FirstDimensionValueTemplate>
<asp:LinkButton runat="server" Text="[Remove]"

CommandName=""RemoveDimensionValue'" />
<%# Eval(‘'DisplayName') %>
</FirstDimensionValueTemplate>

This template defines how dimension values display that occur
between the first and last dimension values (the intermediates). The
formatting you specify applies to all the intermediate dimensions.
You write the template once and it can be rendered any number of
times for each intermediate dimension in a breadcrumb path. The
default markup for the template is:

<IntermediateDimensionValueTemplate>
&gt; <asp:LinkButton runat="'server"
CommandName="SelectDimensionValue™ >
<%# Eval('DisplayName'™) %>
</asp:LinkButton>
</IntermediateDimensionValueTemplate>

This template defines how the last dimension value in a breadcrumb
displays. The formatting you specify applies only to the last dimension
in the breadcrumb path. The default markup for the template is:

<LastDimensionValueTemplate>
&gt; <%# Eval('DisplayName'™) %>
</LastDimensionValueTemplate>

For example:

<LastDimensionValueTemplate>

<%# Eval(‘'DisplayName')%>

<asp:LinkButton runat="'server" Text="(x)" Com-
mandName=""SelectParentDimensionValue" />
</LastDimensionValueTemplate>

This template defines how range values display. For example, this
template replaces the default display with boundaries of the selected
range.

<RangeBreadcrumbTemplate>
<asp:Button runat="server™ Text=""Remove’™ Com-
mandName=""RemoveRangeFilter" />

<span class="Caption">Range: </span>
<asp:PlaceHolder runat="'server™"™ Visible="<%#
Container.Dataltem.Operator ==
RangeFi lterOperator.Between %>">

<W# Eval('Boundl™) %> &lt;= <%# Eval('Prop-

ertyName'™) %>

<= <%# Eval('Bound2') %>

</asp:PlaceHolder>

<asp:PlaceHolder runat="'server™™ Visible="<%#
Container.Dataltem.Operator
== RangeFilterOperator.LessThan %>">
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Template name

SearchBreadcrumbTemplate

SuggestedSearchAdjust-
mentTemplate

Endeca Confidential

Description

<%# Eval('PropertyName'™) %> &lt; <%#
Eval ("'Bound1'™) %>
</asp:PlaceHolder>

<asp:PlaceHolder runat="'server™ Visible="<%#
Container _Dataltem.Operator ==
RangeFilterOperator._.LessThanOrEqual %>">
<%# Eval('PropertyName'™) %> &lt;= <W#
Eval ("'Boundl') %>
</asp:PlaceHolder>

<asp:PlaceHolder runat="'server™ Visible="<%#
Container _Dataltem.Operator ==
RangeFilterOperator.GreaterThan %>">
<%# Eval("'PropertyName') %> &gt; <W#
Eval ("'Boundl') %>
</asp:PlaceHolder>

<asp:PlaceHolder runat="'server™ Visible="<%#
Container.Dataltem.Operator ==
RangeFi lterOperator.GreaterThanOrEqual %>">
<%# Eval(“'PropertyName'™) %> =&gt; <W#
Eval ("'Boundl') %>
</asp:PlaceHolder>

</RangeBreadcrumbTemplate>

This template defines how search terms display. In this example, the
template replaces the default display with an auto correction option;
however, it does not include a Did You Mean option.

<SearchBreadcrumbTemplate>
<asp:Button runat="'server' Text="Remove'™ Com-
mandName=""RemoveSearch" />
<span class="'Caption'>Search: </span><span><{#
Eval (*'Search.Terms') %></span>

<asp:Repeater runat="'server' DataSource="<%#
Eval
('AppliedSearchAdjustments') %>">
<ltemTemplate>
<span class=""Caption'>&gt; Corrected To:
</span> <span><%#
Eval("Terms'™) %></span>
</ltemTemplate>
</asp:Repeater>
</SearchBreadcrumbTemplate>

This template defines how Did You Mean options display. The default
markup for the template is:

<SuggestedSearchAdjustmentTemplate>

<span runat="'server' class="Caption" visi-
ble="<%#

Container_Dataltemlndex > 0 %>"> or </span>

<asp:LinkButton runat="'server' Text="<W#
Eval("'Terms™) %>"
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Template name Description

CommandName=""ApplyAdjustment" />
</SuggestedSearchAdjustmentTemplate>

Creating a Pager control

You create and configure a Pager control in order to provide paging controls on a Web page. You can
set the number of results to display per page.

You must have created a NavigationDataSource control before performing this task.

By default, a NavigationDataSource returns a maximum of ten records for display on a Web page.
Additional results can be displayed on Next or Previous pages as provided by the control. You modify
the items per page value on the NavigationDataSource, not the Pager control. The Pager control
should provide an items per page choice that is equal to the default items per page property of the
NavigationDataSource.

By default, the Pager control displays choices of 10, 20, or 30 items per page. To override this setting,
use the 1'temsPerPageChoices property. For example, if you change 1temsPerPageChoices to
50,100,150 then the user can choose to display a maximum of 50 records, 100 records, or 150
records on a results page.

To create a Pager control:

Open your Web site in Visual Studio.

In the Toolbox window, expand the Endeca RAD Toolkit tab.

Drag the Pager control on to the Design tab of your Web page.

Select the Pager and click the Smart Tag.

From the Choose Data Source list, select a NavigationDataSource control.

In the Properties window of Visual Studio, modify the following properties for the Paging control:
Property Description

ok wdhPRE

ItemsPerPageChoices Optional. Specifies the number of results per page available to the
user. Clicking one of the page sizes displays that number of results
per page. To modify the default number of results per page, change
10,20, 30 to page size values of your choice. For example, changing
this property to 50,100,150 creates three page size options in
increments of 50, 100, and 150 records per page.

ltemsPerPageChoicesLabel Optional. Specifies a caption before listing the items per page
choices, for example, Results Per Page.

OffsetChoicesLabel Optional. Specifies a caption before listing the offset choices, for
example, Page.

RenderinTable Optional. Specifies whether to render the control in a table format.
The default value is False.

NextBlockText Optional. Specifies the marker the user clicks for next block of pages.
The default value for NextBlockText is >>. For example, if the
PageButtonCount is 5, then clicking >> moves the set of pages
from 1-5 to 6-11, and so on.
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Property
NextPageText

PageButtonCount

PreviousBlockText

PreviousPageText

ItemsType

UrlManagerld

NextBlocklmageUrl

NextPagelmageUrl

PreviousBlockimageUrl

PreviousPagelmageUrl

Description

Optional. Specifies the marker the user clicks for the next page of
results. The default value for NextPageText is >.

Optional. Specifies the number of pages that display when a user
clicks >> (indicated by the NextBlockText property) or the user
clicks << (indicated by the PreviousBlockText property). The

default value for PageButtonCount is 5.

Optional. Specifies the marker the user clicks for previous block of
pages. The default value for PreviousBlockText is <<. For
example, if the PageButtonCount is 5, then clicking >> moves the
set of pages from 1-5 to 6-11, and so on. The default value for Pre-
viousBlockText is <<.

Optional. Specifies the marker the user clicks for the previous page
of results. The default value for PreviousPageText is <.

Required. Select RecordsResul t if you want the number of results
per page to be based on record count. Select AggregateRecord-
sResul t if you want the number of results per page to be based on
aggregate records.

Optional. Specifies the name of the Ur IManager that builds URLs
for the control.

Optional. Specifies an image that the user clicks for next block of
pages. Setting an image for NextBlocklImageUr1 overrides the
value of NextBlockText.

Optional. Specifies an image that the user clicks for the next page
of results. Setting an image for NextPage ImageUr 1 overrides the
value of NextPageText.

Optional. Specifies an image that the user clicks for previous block
of pages. Setting an image for PreviousBlockImageUr| overrides
the value of PreviousBlockText.

Optional. Specifies an image that the user clicks for the previous
page of results. Setting an image for PreviousPage ImageUrl
overrides the value of PreviousPageText.

Pager example code
The code generated on the Source page is similar to the following:

<cc2:Pager ID="Pagerl" runat="server' DataMember=""RecordsResult"
DataSource ID="NavigationDataSourcel™
I temsPerPageChoices="10,20,30">

</cc2:Pager>

Here is an example Pager control as rendered on a Web page:
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Pager control templates

The Pager control supports several templates that allow you to modify the default presentation of the
control. Each template in the control has default markup that is part of the Endeca.Web .Ul .WebCon-
trols assembly. You can override the default presentation as necessary by providing your own

markup in the templates.

Template name

I temsPerPage-
ChoiceTemplate

NextBlockTemplate

NextPageTemplate

Description

This template defines the page size choices available to the user. The
default markup for the template is:

<ltemsPerPageChoiceTemplate>
<asp:LinkButton runat="'server' CommandArgument=""<Y#

Container.Dataltem. ItemsPerPage %>'" Command-
Name=""Changel temsPerPage""

Visible="<%# 1Container_Dataltem.lIsSelected %>">

<%# Container.Dataltem.ltemsPerPage

%></asp:LinkButton>

<asp:Label ID="Label2" runat="server" Text="'<W#

Container.Dataltem. ItemsPerPage %>" Visible="<%#

Container _Dataltem.IsSelected %>"/>
</l1temsPerPageChoiceTemplate>

This template defines the user interface element the user clicks for next
block of pages. The default markup for the template is:

<NextBlockTemplate>
<asp:LinkButton runat="'server' CommandArgument=""<%#
Container.Offset %>"
CommandName=""ChangeOffset"” >
<%# Container.Text %></asp:LinkButton>
</NextBlockTemplate>

In this example, this template replaces the default element of >> with linked
text that displays Next Block

<NextBlockTemplate>
<asp:LinkButton runat="'server' Text="Next Block"
CommandName=""ChangeOffset"
CommandArgument="<%# Container.Offset %>'>
</asp:LinkButton>
</NextBlockTemplate>

This template defines the user interface element the user clicks for the next
page of results. The default markup for the template is:

<NextPageTemplate>
<asp:LinkButton runat="server' CommandArgument=""<Y#

Container.Offset %>" CommandName="'ChangeOffset" >
<%# Container.Text %></asp:LinkButton>
</NextPageTemplate>

In this example, this template replaces the default element of > with linked
text that displays Next Page.
<NextPageTemplate>

<asp:LinkButton ID=""NextPageldl' runat="'server"
Text=""Next Page"
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Template name

PreviousBlockTem—
plate

PreviousPageTem-
plate

NoResultsTemplate

Endeca Confidential

Description

CommandName=""ChangeOffset' CommandArgument=""<%#
Container.Offset %>'">
</asp:LinkButton>
</NextPageTemplate>

This template defines the user interface element the user clicks for previous
block of pages. The default markup for the template is:

<PreviousBlockTemplate>
<asp:LinkButton runat="'server' CommandArgument=""<%#

Container.Offset %>'" CommandName="'ChangeOffset" >
<%# Container.Text %></asp:LinkButton>
</PreviousBlockTemplate>

In this example, this template replaces the default element of << with linked
text that displays Previous Block.

<PreviousBlockTemplate>
<asp:LinkButton runat="server' Text="Previous Block"

CommandName=""ChangeOffset"
CommandArgument=""<%# Container.Offset %>'>
</asp:LinkButton>
</PreviousBlockTemplate>

This template defines the user interface element the user clicks for the
previous page of results. The default markup for the template is:

<PreviousPageTemplate>
<asp:LinkButton runat="'server' CommandArgument=""<Y#

Container.Offset %>" CommandName="'ChangeOffset" >
<%# Container.Text %></asp:LinkButton>
</PreviousPageTemplate>

In this example, this template replaces the default element of < with linked
text that displays Previous Page

<PreviousPageTemplate>
<asp:LinkButton ID="NextPageldl" runat="'server"
Text=""Previous Page"
CommandName=""ChangeOffset' CommandArgument=""<%#
Container.Offset %>"></asp:LinkButton>
</PreviousPageTemplate>

This template defines what to display when no results are returned. The
default markup for the template is:

<NoResultsTemplate>
0 Matching Records
</NoResultsTemplate>

In this example, the template replaces "0 matching records” with "No
results".

<NoResultsTemplate>
<div>No results</div>
</NoResultsTemplate>
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Template name

OffsetChoiceTem—
plate

PagerResultsTem-
plate

Description

This template defines the list of pages to display. This is typically < 1,
2, 3, 4, >and so on. The default markup for the template is:

<OffsetChoiceTemplate>
<asp:LinkButton runat="'server' CommandArgument=""<%#
Container _Dataltem.Offset
%>"" CommandName=""ChangeOffset' Visible="<%# IContain-
er _Dataltem.lIsSelected %>">
<%# Container.Dataltem.DisplayValue
%></asp:LinkButton>
<asp:Label ID="Labell™ runat="server"
Text="<%# Contailner.Dataltem._DisplayValue %>" Vis-
ible="<%#
Container.Dataltem.lIsSelected %>"/>
</OffsetChoiceTemplate>

For example:

<OffsetChoiceTemplate>
<asp:LinkButton runat="'server' Visible="<%# !Contain-
er _Dataltem.IsSelected %>"
Text="<%# Container.Dataltem.DisplayValue %>"
CommandName=""ChangeOffset"
CommandArgument="<%# Container _Dataltem.Offset
%>""></asp:LinkButton>
<asp:Label runat="'server" Visible="<%# Contain-
er _Dataltem.IsSelected %>"
Text="<%# Container.Dataltem.DisplayValue
%>""></asp:Label>
</OffsetChoiceTemplate>

This template defines the three data items that indicate the first index of
page results, last index page, and total number of results. The default
markup for the template is:

<PagerResultsTemplate>

Results <asp:Label runat="server"

Text="<%# Container.Paginglnfo.FirstindexOfPage %>"
/> - <asp:Label

runat=""server' Text="'<W# Container.Paginglnfo.Lastln-
dexOfPage %>" />

of <asp:Label ID="Label3" runat="server"™ Text="<W#

Container.Paginglnfo.Total ItemCount %>" />
</PagerResultsTemplate>

In this example, this information displays similar to Resullts 1 - 10 of
596 where 1 is the first index, 10 is the last index and 596 is the total
number of results. For example:

<PagerResultsTemplate>

<span>Results:</span>

<asp:Label I1D="firstlndexldl" runat="server"
Text="<%# Container.Paginglnfo.FirstindexOfPage %>"/>

<span>-</span>

<asp:Label ID="lastindexld1" runat="'server"
Text="<%# Container._Paginglnfo.LastlndexOfPage %>'"/>

<span>of</span>

<asp:Label I1D=""totalRecordsldl™ runat="server"
Text=""<%#
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Template name Description

Container.PagingInfo.Total ItemCount %>"/>
</PagerResultsTemplate>

Working with a tag cloud

A TagCloud control renders the most frequently used tags or most relevant tags in a dimension as a
Web page control. When an application user clicks a tag, the control produces query results that
correspond with the selected tag, and the control produces a new set of tags to refine subsequent
gueries within the dimension.

Dimension requirements
There are several requirements for the dimension that you associate with a TagCloud control;

« The dimension must be exposed. To expose the dimension, either a user can select the dimension,
or you, the developer, can set the dimension to be exposed. If a dimension is not exposed, the
tag cloud does not have any tags to render on the page and outputs the EmptyTemplate.

« The dimension must be identified to the TagCloud control.

« The dimension must have Compute refinement statistics enabled to calculate the correct tag
size. If this is not enabled, all tags render as the same size. You enable the Compute refinement
statistics option on the Dimension editor of Developer Studio. See Endeca Developer Studio Help
for details.

Typical use case for a tag cloud

In a typical use case for a tag cloud, you create a dimension of extracted terms that spans the entire
record set for your application and associate that dimension of extracted terms with the TagCloud
control.

In addition to the items listed in the "Dimension requirements" section, this use case relies on the
following additional tasks:

* Create a dimension of extracted terms. For more information, see the "Implementing Term Discovery
and Cluster Discovery" chapter of the Endeca Relationship Discovery Guide.

< Exclude the dimension of extracted terms from the navigation menu of the Web page. This
dimension is simply a container for the extracted terms and not the kind of dimension a user would
click on to navigate. As such, you exclude it from the navigation menu.

Creating a TagCloud control

You create a TagCloud control and associate it with one dimension. The TagCloud control creates
tags based on the dimension values in that dimension.

You must have created a NavigationDataSource control before performing this task.

To create a TagCloud control:

Open your Web site in Visual Studio.

In the Toolbox window, expand the Endeca RAD Toolkit tab.

Drag the TagCloud control on to the Design tab of your Web page.

Select the TagCloud control and click the Smart Tag.

From the Choose Data Source list, select a NavigationDataSource on the page.

a s wbdpRE

Endeca Confidential Endeca® RAD Toolkit for ASPNET Developer's Guide



52 Creating an application using Endeca server controls | Working with Endeca user interface controls

6. Inthe Properties window of Visual Studio, modify the following properties for the TagCloud control:

Property

DataMember

DimensionID

UrlManagerld

MaximumNumberOfTags

SelectAction

SearchKey

SearchMode

Sizing

SortType

TagSizeCount

Description

Required. You can set this to DimensionStatesResult and specify
a number for the Dimension 1D property. Alternatively, you can identify
the dimension for the tag cloud by specifying the DataMember as
DataMember="DimensionStatesResult_.RefinableDimension-
States[''Name'] " where Name is the actual name of the dimension.
For example, DataMember="DimensionStatesResult.Refin-
ableDimensionStates[''Region™] " bases the tag cloud on the
Region dimension in the sample wine application.

Required if you set DataMember to DimensionStateResul t. Specify
the ID of the dimension you want to create the control for. (You can
determine a dimension ID by looking at the Dimensions View of
Developer Studio or you can examine your dimensions . xml file after
running Forge.)

Optional. Specifies the name of the Ur IManager that builds URLs for
the control.

Optional. Specify a number to restrict the total number of tags that
display in the tag cloud. For example, if you specify 7, then the tag cloud
contains up to a maximum of 7 tags. It is good practice to restrict the
number of tags if the dimension has many dimension values.

Optional. Choose an option to specify what happens when a tag is
clicked. Choose Navigate to indicate that clicking the tag is the same
as navigating to the dimension value of the same name. Choose Search
to indicate that clicking the tag performs a search for the text of the tag
name within the dimension. If you set SelectAction to Search, also
set SearchKey and SearchMode to specify what search mode is used
when a search is performed. The default value for SelectAction is
Navigate.

Optional. Use when SelectAction is set to Search. Specify the
name of the Endeca property or Endeca search interface to search on.
The default value for SearchKey is Al I.

Optional. Use when SelectAction is set to Search. Choose one of
the standard Endeca match modes for the tag cloud. For more
information about match modes, see the Endeca Basic Development
Guide.

Optional. Specify what the display of tags is based on within a
dimension. Select Frequency to display tags based on record count.
The greater the number of records that contain a tag, the larger the tag
size on a Web page. Or select Relevancy to calculate the relevance
of a tag based on its frequency in the current result set as compared
to its frequency across the entire dataset (an implementation of the F
Measure algorithim). The default value for Sizing is Frequency.

Optional. Choose either Alphabetical to list tags alphabetically, or
choose Default to list tags in the order returned from the MDEX
Engine. The default value for SortType is Alphabetical.

Optional. Specify the number of distinct sizes for tags in the controls.
You can choose a value from 1 to 9. For example, if you specify 7 , you
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Property Description

can have up to 7 different sized tags in the tag cloud. If you want a value
of 10 or greater, you have to customize your page's CSS to support
that sizing. The default value for TagSizeCount is 6.

TagCloud example code

In a simple case, the mark up generated on the Source page of Visual Studio is similar to the following
(your dimension ID varies):

<cc2:TagCloud runat="server' DataSourcelD="NavigationDataSourcel™
Dimensionld="3">
</cc2:TagCloud>

Here is an example TagCloud control as rendered on a Web page:

Body crisp Firm Fresh Full Full-sodied Rich Ri PE sort Tannins

TagCloud control templates

The TagCloud control supports several templates that allow you to modify the default presentation of
the control. Each template in the control has default markup that is part of the Endeca.Web .Ul .We-
bControls assembly. You can override the default presentation as necessary by providing your own
markup in the templates.

Template name Description
DimensionValueTem- | This template defines the dimension value name with the contents of the
plate template. The default markup for the template is:

<DimensionValueTemplate>
<asp:LinkButton runat="server"

CssClass="<%# "'Tag'" + Contailner.TagSize + " " +
(Container.Dataltemlndex
% 2 == 0 ? "ltem" :© "Alternatingltem™) %>"

CommandName="<%# TagCloud.SelectAction == Tag-
CloudSelectAction.Navigate ?

"SelectDimensionValue"™ : "SearchForDimensionVal-
ue™ %>*

Text="<%# Eval ("'DisplayName'™) %>" />
</DimensionValueTemplate>

Here is an example that creates a tag cloud with dimension value names
and their corresponding number of records in parentheses:

<DimensionValueTemplate>

<asp:LinkButton runat="server’ CssClass ="<%# "Tag"
+ Container.TagSize %>"

OonClick=""Navigate'" CommandArgument="<%# Eval('1d')
%w>">

<%# Container.RecordCount%>

</asp:LinkButton>

<span>(<%# Container .Dataltem.RecordCount %>)</span>

</DimensionValueTemplate>
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page

Template name

SeparatorTemplate

EmptyTemplate

Description

This example relies on you defining a method for Navigation:
protected void Navigate(object sender, EventArgs e)

{

NavigationDataSource navDatasource = BindingUtili-
ty.FindDataSource<NavigationDataSource>(""dsNav', this);

LinkButton link = (LinkButton)sender;
navDatasource.SelectedDimensionValuelds.Add(link.Com-
mandArgument) ;

This template defines the default tag separator (a space) with the contents
of the template. The default markup for the template is:

<SeparatorTemplate> </SeparatorTemplate>

Here is an example that replaces the space with | between tags:
<SeparatorTemplate>|</SeparatorTemplate>

This template defines the content to display if the tag cloud is empty. The
default markup for the template is:

<EmptyTemplate></EmptyTemplate>

Here is an example that adds the text No tags available. to an
otherwise empty control area:

<EmptyTemplate>No tags available.</EmptyTemplate>

Setting a dimension to be exposed on aWeb page

In some scenarios, you may want to force a dimension to be exposed (open) on a Web page. This is
necessary, for example, when using a TagCloud control.

To set a dimension to be exposed on a Web page:

A wbdpE

Open your Web site in Visual Studio.

Select the NavigationDataSource control on the page.

In the Properties window of Visual Studio, locate the PermanentRefinementConfigs property.
In its value field, click Browse....

The RefinementConfig Collection Editor displays.

o

In the RefinementConfig Collection Editor, click Add.

6. Specify a value for the DimensionValueld property that identifies the dimension you want to be

exposed.
7. Click OK.
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Open dimension example code

The mark up generated on the Source page of Visual Studio is similar to the following (your dimension
varies):

<PermanentRefinementConfigs>
<end:RefinementConfig DimensionValueld="3">
</end:RefinementConfig>

</PermanentRefinementConfigs>

Excluding a dimension from the navigation menu

In some scenarios, you may want to exclude a dimension from the navigation menu of a Web page.
This is necessary, for example, if you create a dimension of extracted terms for use with a TagCloud
control. In this case, the extracted terms span the entire data set and the dimension serves as a
container for the terms; you do not want application users to navigate to that dimension.

You must have already created and configured a GuidedNavigation control before performing this
task.

To exclude a dimension from a navigation menu:

Open your Web site in Visual Studio.
Select the GuidedNavigation control on the page.
In the Properties window of Visual Studio, locate the ExclusionDimensionlds property.

In its value field, click Browse....
The String Collection Editor displays.

Specify the dimension ID that you want to exclude from the navigation menu.
6. Click OK.

A owbdpR

o

Exclude dimension example code

The markup generated on the Source page of Visual Studio is similar to the following (your dimension
ID will vary):

<cc2:GuidedNavigation runat="'server' DataSourcelD="NavigationDataSourcel"
ExclusionDimensionlds="3">
</cc2:GuidedNavigation>

Renaming dimensions or dimension values before
displaying them on a page

You can rename dimensions and dimension values before displaying them on a Web page. You
rename a dimension in the dimensions.xml file and rename a dimension value using Developer
Studio. In either case, you add a DisplayName property to the dimension or dimension value. This
is part of your MDEX Engine configuration. If the property exists, the RAD Toolkit displays the new
name in your application.

You may want to rename dimensions or dimension values before displaying them on a Web page in
two cases:
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« For internationalization, where you need one MDEX Engine to serve dimensions or dimension
values with varying locale designations.

« As aworkaround in cases where EQL places name restrictions on dimensions or dimension values
that you do not want to affect your Web site (i.e. EQL does not allow spaces in names but you
may need spaces in names).

To rename a dimension or dimension value before displaying it on a page:

1. To rename a dimension:

a)

b)
c)

d)

Open the dimensions.xml file in a text editor. (This file is typically stored in the forge_input
directory.)

Locate the dimension you want to rename by its DIMENSION element.

In the DIMENSION element, add a PROP element with a NAME=""DisplayName" attribute as
shown in the next step.

Specify the new display name in the PVAL element. This example renames the Price Range
dimension to the Price dimension.

<DIMENSION NAME="Price Range'"™ SRC_TYPE=""INTERNAL">
<DIMENSION_ID ID="10"/>
<DIMENSI10N_NODE>
<DVAL TYPE="EXACT">
<DVAL_ID ID="10"/>
<SYN CLASSIFY="FALSE"™ DISPLAY="TRUE"™ SEARCH="FALSE'>Price
Range</SYN>
<PROP NAME="DisplayName"'>
<PVAL>Price</PVAL>
</PROP>
</DVAL>

<I-- Other dimension values removed from the example. -->

</DIMENSION>

e) Save and close the dimensions.xml file.

2. Torename dimension values, see the "Providing additional descriptive information for a dimension
value" topic in the Endeca Developer Studio Help. When following the procedure in the Endeca
Developer Studio Help, add a property called DisplayName to the dimension value with a name
you want to display on the Web page.

%
Note: If you prefer to use a property with a name other than displayName, define the
property in web . config using a different propertyName value as shown below. The
example uses displayName_en_us instead of displayName.

<endeca>

<displayName propertyName="displayName_en us" />

</endeca>

3. Open the web.config file for your Web site and add the following displayName section:
<configSections>

<l-- Other sections removed from the example. -->

<section name="'displayName" type=""Endeca.Data.Configuration.Display-

NameSection,

Endeca.Data, Version=2.1.0.0, Culture=neutral, PublicKeyTo-

ken=6d02be8724ca751c' />
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</sectionGroup>
</configSections>

4. Run a baseline update.

Generating the "More..." link

The Presentation API for .NET handles the "More..." link differently than the RAD API for ASP.NET.
The Presentation API for .NET generates the "More..." link in situations where all of the following occur:

* You select the Enable dynamic ranking option in the Dimension editor of Developer Studio.

* You select the Generate "More..." dimension value option in the Dimension editor of Developer
Studio.

» The MDEX Engine returns query results with more dimension values than the cut off threshold
you specified in Maximum dimension values to return.

However, the RAD API ignores the Generate "More..." dimension value option in Developer Studio
and automatically generates a "More..." link when either:

* You select Enable dynamic ranking in Developer Studio and the MDEX Engine returns more
dimension values than the cut off threshold allows.

* You use RefinementConfigs to set a limit on the number of dimension values to return, and the
MDEX Engine returns more dimension values than the cut off threshold allows.

To control which dimensions will display a "More..." link, override the
ShowMoreDimensionValuesTemplate in the GuidedNavigation control.

> . . . .
77 Note: In afuture release of Developer Studio, the Generate "More..." dimension value option
will be phased out.

Displaying guery results on a Web page

Many Visual Studio controls allow you to display query results on a Web page. For example, using a
DataList control to display results is one expedient way that is described here.

You must have already created and configured a NavigationDataSource control.

To display query results on a Web page:

Open your Web site in Visual Studio.

In the Toolbox window, expand the Data tab.

Drag a DataL.ist control onto the Design page.
Select the DataList control and click the Smart Tag.

From the Choose Data Source list, select an Endeca data source control. Typically this is the
NavigationDataSource on the page.

6. Inthe Properties window of Visual Studio, modify the following properties for the DataL.ist control:

a s wDd e
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Property Description

DataMember Required. Set this to RecordsResult_Records to display Endeca
records or setitto AggregateRecordsResult.AggregateRecords
to display aggregated records.

7. Select the DataList control and click the Smart Tag.
8. Select Refresh Schema.

If you build the Web site at this point, the data items available to RecordsResult._Records or Ag-
gregateRecordsResult.AggregateRecords display in the DatalList control. You can iterate
over these collections to extract and display additional record information. For instructions, see
"Displaying nested record properties".

Displaying nested record properties

An Endeca Record object contains dimension values and properties. You can iterate over these
collections, using one or more Repeater controls, to extract and display additional Record properties.
This topic describes one way to extract and display the nested properties.

To display nested record properties:

Open your Web site in Visual Studio.

In the Toolbox window, expand the Data tab.

Drag a Repeater control onto the Design page.

From the Smart Tag, select an Endeca data source control. The RecordDetailsDataSource returns
a single Endeca record, so it is convenient for this example.

Select the Repeater control and then select the Source page of Visual Studio.

6. Add .NET Eval expressions as necessary to iterate over each Record property that you want to

expose on the Web page. See the Endeca API Reference for the RAD Toolkit for ASP.NET for the
available properties of an Endeca Record.

A owbdpR

o

Displaying total record count

You can use common Visual Studio controls to display the total number of records that match a query.
You must have already created and configured a NavigationDataSource control.

To display total record count:

Open your Web site in Visual Studio.

In the Toolbox window, expand the Data tab.

Drag a FormView control onto the Design page.
Select the FormView control and click the Smart Tag.

From the Choose Data Source list, select an Endeca data source control. Typically this is the
NavigationDataSource on the page.

6. Inthe Properties window of Visual Studio, modify the following properties for the FormView control:

a s wbdpRE
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Property Description
DataMember Required. Set this to RecordsResul t to display Endeca
records.

7. Select the FormView control and clickEdit Templates.

8. Drag a Label control into the ItemTemplate.

9. Select the Label control and click Edit Templates.

10. In Bindable properties, select Text.

11 Click the Field Binding option, and from the Bound to list, select TotalRecordCount.
12. Click OK.

13 Next to the Label control, add descriptive text, such as, Total records returned:
14. On the FormView control, select End Template Editing.

When you build your Web site, you see the total record count displayed on the page.

Record count example code

The markup generated on the Source page of Visual Studio is similar to the following:

<asp:FormView ID="FormViewl"™ runat="server' DataSourcelD="NavigationData-

Sourcel"
DataMember="RecordsResult'>
<ItemTemplate>

<asp:Label ID="Labell”™ runat="server"™ Text="<W# Eval(*'TotalRecord-
Count') %>"></asp:Label>
Total Record Count
</l1temTemplate>
</asp:FormView>
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Chapter 4

Creating an application based on the
reference application

This section provides a brief overview of how to create an Endeca front-end application using the RAD
ASP.NET reference application as a starting point. In this scenario, the reference application acts as
a template that you copy and modify as needed until it meets your application requirements.

High level process of creating an application from a
reference application

The basic workflow is as follows:

1.

Copy the reference application from <installation path>\Endeca RAD Toolkit
-NET\reference\RadAspNet to a staging area.

Apply your custom cascading style sheet (CSS) to the Web pages.

Modify the pages and controls for your requirements. This is the bulk of the work. In this step, you
modify the refence application's search and navigation features such as dimension controls, paging
controls, breadcrumb controls, and so on.

Delete any pages and controls that are not necessary in your application.

Test and deploy your Web site.

Using reference application controls in your application

In cases where you need only a few user controls, you probably do not want to create an Endeca
application based on the reference application. For example, you might already have a partial application
running and you simply want to copy individual user controls from the reference application and reuse
them in your application.

Endeca provides user controls in the reference application for search boxes, record details, range
filters, dynamic business rules, and so on that can be reused.

To use reference application controls in your application:

1.

Open Windows Explorer and go to one of the following locations:

« If your application uses HTTP postbacks, goto <installation
path>\Endeca\RADToolkits\version\ASP .NET\reference\RadAspNetRe\Resources\UserControls.
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« If your application uses URL query parameters, goto <installation
path>\Endeca\RADToolkits\version\ASP _NET\reference\RadAspNetRe\ResourcesUr N\UserControls.

2. ldentify a user control you want and copy both the ASCX and ASCX.CS file for the control to a
directory of your choice within your Web site directory structure. It is useful to create a
\UserControls directory, or something similar, if you do not already have one in place.

3. Open your Web site in Visual Studio.

4. In the Solution Explorer, right-click your Web site and select Add > Existing Item....

5. Browse to the ASCX and ASCX.CS file for the user control, select the files, and click Open.

You may or may not get dependency errors for missing helper classes and methods. If you do,
copy help code from <installation
path>\Endeca\RADToolkits\version\ASP_NET\reference\RadAspNetRef\App_Code

The user control displays in the Solution Explorer file list but not in the Toolbox window. Also, no design
time data is sent to the user control. It displays as "databound" in the Design tab of Visual Studio.
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Chapter 5
Overview of building URLSs

The RAD Toolkit for ASP.NET provides classes to build URLs in your application. This can include
links to dimensions, dimension values, records, aggregate records, and so on. The classes in Ende-
ca.Web._Url do this work, especially the Ur IManager class and the UrIBui Ider class. This section
describes how to work with these classes.

About building URLs

This topic describes the basics of building and serializing URLSs.
- . . . . . . I . .
"~ Note: This guide describes the basic tasks involved in building URLs using the RAD Toolkit for
ASP.NET. If you are using the URL Optimization API with your application, there are some
important additional considerations to ensure properly optimized URLSs. For details, please refer
to the URL Optimization API for the RAD Toolkit for ASP.NET Developer's Guide.

The process to build URLs
The high-level process to build a URL is as follows:

1. Create a UrIManager object and register the data sources and commands on your page. The
primary function of Ur IManager is to keep track of the commands that contribute to the URL that
is getting built.

2. Initialize the Ur IManager with the state encoded in a URL by calling Initial izeFrom(String).
This state is setting up the commands properly to fetch the correct data to render on the page. You
are taking the state encoded in a URL, copying that state, and modifying that state to build additional
URLs.

3. Build a new URL by modifying the copies of commands registered with the Ur IManager. This
modification may include toggling dimensions, and selecting dimensions, dimension values, adding
records, adding parameters, or any other change that represents a new URL in an application.

You can use the convenience methods in UrBui lder to build URLs such as

e SelectDimensionValue

« SelectParentDimensionValue
» SelectRecord

« SelectAggregateRecord

You can use the more generic Bui 1ldUr 1 method. (Behind the scenes, the convenience methods call
Buildurl))
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The following diagram illustrates steps 1 and 2.

 The first box represents an empty NavigationDataSource with an ID of dsNav.

« The second box represents the default Ur IManager that registers the empty NavigationData—
Source and then initializes itself from the current base URL.

« The third box represents the data source populated with the parameters from the current URL

MNavigationDataSource
|10 = dsMaw
SaelectedDimensionValualDs =[]

Register|{dsMawv)
¥
UriManager
|0 = Default

Basalr = GuidedMavigation, aspx

InifalizeFrom{/GuidedNavigation.aspx 7dsNav=N:123+456+T89)

v

MavigationDataSource
ID = dsMav
SeleciedDimensionValuelDs = [123.456, 789]

The following diagram illustrates step 3.
 The first box represents a data source populated with a navigation state of two dimension value
IDs (123 and 456).

» The second box represents a Ur IManager that builds a new URL based on a copy of the navigation
state (123 and 456)and includes the addition of another dimension value ID (789).

MavigationDataSource
ID = dsMav
SalactedDimensionValuelDs = [123,456]

I
HegisteraNav]

UriManager
1D = Dafauit
BaselUrl = GuidedNavigation aspx

Uris. SelectDimensionvalua{lD = TB9)

IGuidedMavigation.aspx ?dsNav=N:123+456+ 789
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About URLs in the reference application

The reference application located in \instal lation
path\Endeca\RADToolkits\version\ASP.NET\reference\RadAspNetReT makes extensive
use of Bui IdUr 1 and the convenience methods to build URLSs.

Examine the files in \instal lation
path\Endeca\RADToolkits\version\ASP_NET\reference\RadAspNetRef\Resources\Ur \UserControls
for typical URL examples.

About URL serialization

The Ur IManager serializes each data source and command into a URL query string. To do this, the
Ur IManager relies on default classes provided with the API.

The UrIManager's default UrIProvider is the BasicUrlProvider. The BasicUrlProvider
serializes each data source using, by default, UriICommandSerializationProvider. These
serialized data sources become the query parameters on the URL where the name of the parameter
is the data source ID. The value is the serialized data source string.

To help illustrate which classes are responsible for each part of serialization, here is an example of
an Endeca URL:

http://localhost:port/RadAspNetRef/Url .aspx?
dsNavl=Nrc:id-6200,N:8021&dsNav2=Nrc:i1d-2,N:4294960252

The section of the URL starting with the question mark, that is,
?dsNavl=Nrc:i1d-6200,N:8021&dsNav2=Nrc:id-2,N:4294960252, represents the Endeca-
Command in the URL and it is serialized by Ur ICommandSerial izationProvider. The entire URL
is then serialized by BasicUrlProvider.

Customizing URL serialization

URL serialization happens entirely as an implementation detail if you are using the default classes
provided with the API.

If you want to customize how EndecaCommand objects are serialized within a URL, you can subclass
and customize CommandSerializationProvider. Similiarly, if you want to customize the way the
entire URL is serialized, you can subclass and customize Ur IProvider and set the Ur IManager .Ur -
Provider property. You can subclass and customize either one or both of these classes.

If you customize the CommandSerializationProvider, you specify the new provider in the
application's Web . config file as shown in this example:

<commandSerialization defaultProvider="Postback">
<providers>
<add name="Postback"
type=""Endeca.Data.DefaultCommandSerializationProvider, Endeca.Data"
/>
<add name="Url"
type=MyNameSpace .MyCommandSerial izationProvider" />
</providers>
</commandSerialization>
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If you customize the UrIProvider, you specify the assembly-qualified type name for the new provider
in the application's Web . config file as shown in this example:

<urlProvider defaultType=""MyNameSpace.MyUrlProvider, MyAssembly' />

You can also override this default setting with a line of code similar to the following:
UriManager .Default.UrlProvider = new MyUrlProvider()

Creating a UrIManager and registering data sources and
commands

You register data sources and commands with a UrIManager so the Ur IManager can construct
URLSs based on the state of these objects and initialize these objects from the state encoded in a URL.
The registration should happen early in a page's life cycle, such as during the Page_Load or Onlnit
methods.

The example below requires the following statements at the top of your code:

using System;

using Endeca.Data;
using Endeca.-Web.Ul;
using RadAspNetRef;
using Endeca.Web.Url;

This procedure assumes you have already created data sources or commands in your application and
assigned them an ID.

For example, this snippet shows two data sources, each with an ID value:

<end:NavigationDataSource
ID=""dsNav""
runat="'server"
MdexHostName=""<%$ Snippet: mdex.MdexHostName %>"
MdexPort="<%$ Snippet:_mdex.MdexPort %>">
</end:NavigationDataSource>

<end:RecordDetai lsDataSource
I1D=""dsRecordDetails"
runat="'server"
MdexHostName=""<%$ Snippet:_mdex.MdexHostName %>""
MdexPort="<%$ Snippet:_mdex.MdexPort %>">
</end:RecordDetai lsDataSource>

There are two ways of creating a Ur IManager. The first way is by calling Ur IManager .Get and
specifying a name as input. If a Ur IManager by that name does not exist, the method creates it. The
second way uses a convenience property named Defaul t to create the Ur IManager with a name
of "Default". This is the equivalent to the first way of calling Ur IManager .Get(*'Default'"); however,
the convenience property simply allows you to create the Ur IManager in one line of code.

After creating the Ur IManager, you register one or more data sources and commands with it. You
register a data source or command by calling Ur IManager .Register. The input to Register is
an interface called 1CommandProvider that allows access to both data sources and commands.

To register data sources and commands:

1. Create a UrIManager object using either of the ways described above.
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2. Register each data source or command in the application by calling Regi ster and specifying each
data source ID.

Example of registering data sources

// Create a new UrlIManager with the name Default if it
// does not exist already.
UrIManager .Get("'Default™);

// Registers a data source named dsNav with the UrlIManager
// named Default.
UrIManager .Register(dsNav);

// Registers a data source named dsRecDetails with the
// UrlManager named Default.
UrIManager .Register (dsRecDetails);

This example is logically equivalent to the example above but shorter:

// The APl provides a convenience method called Default

// to create a new instance of UrlIManager.

// This creates a UrlIManager and registers two data sources
// with it.

UrIManager .Default_Register(dsNav);

UrIManager .Default.Register(dsRecDetails);

Go on to "Initializing a UrIManager".

Initializing a UrIManager

After registering data sources and commands, you initialize the Ur IManager by calling Initialize-
From. This call uses the current URL in an application to populate the data sources and commands
registered with Ur IManager with state encoded in a URL. The initialization should happen early in a
page's life cycle, such as during the Page_Load or Onlnit methods.

The example below requires the following statements in your code:

using System;

using Endeca.Data;
using Endeca.Web.Ul;
using RadAspNetRef;
using Endeca.-Web._Url;

To initialize a UrIManager:

Add code to call InitializeFrom and provide Request.Url.

Example of initializing a UrIManager

// The APl provides a convenience method called Default

// to create a new instance of UrlManager.

// This creates a UrlIManager and registers two data sources with it.
UrlIManager .Default.Register(dsNav);

UrIManager .Default_Register(dsRecDetails);

// Initialize the UrlIManager with state from the Request.Url.
UrIManager.Default. InitializeFrom(Request.Url);
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Building a URL to toggle a dimension and display its
dimension values

You can build a URL that toggles a dimension open or closed by calling UrIBui Ider.ToggleDimen-
sionStateExposure and you can build URLSs for the dimension values within it by calling Select-
DimensionValue.

The example below requires the following statements in your code:

<%@ Register TagPrefix="end" Assembly=""Endeca.Web"
Namespace=""Endeca.Web.UI" %>
<%@ Register TagPrefix="end" Assembly="Endeca.Web.Ul_WebControls™
Namespace=""Endeca.-Web_UI" %>
<%@ Import Namespace='"Endeca.Data" %>
<%@ Import Namespace="Endeca.Web.Url" %>

This procedure assumes you have already created data sources or commands in your application and
assigned them an ID.

The ToggleDimensionStateExposure method builds a URL for the dimension you want to toggle
and SelectDimensionValue builds a URL for each dimension value within that dimension.

To build a URL to toggle a dimension open or closed:

1. To build URLs for each dimension, create a repeater control with the following markup:
a) Specify the data source for the dimension.
b) Specify DimensionStatesResult as the DataMember property.

¢) Call ToggleDimensionStateExposure and identify the dimension to toggle. The method is
overloaded, so you can identify the dimension either by DimensionState or by context path.

2. To build URLs for each dimension value, create a nested repeater control within the repeater that
contains ToggleDimensionStateExposure, and add the following markup:

a) Specify the data source for the dimension values.
b) Call SelectDimensionValue and identify the dimension. The method is overloaded, so you
can identify the dimension either by DimensionValue or by context path.

Example markup for toggleing a dimension and showing its dimension values

<asp:Repeater runat="server'™ DataSourcelD="dsLeft"
DataMember="DimensionStatesResult_RefinableDimensionStates'>
<ltemTemplate>
<a
href="<%# UrlIManager.Default.Urls.ToggleDimensionStateExpo-
sure(dsLeft.ID,
Container.Dataltem) %>'>
<%# Eval('Dimension.DisplayName'™) %>
</a> <br />
<asp:Repeater runat="'server' DataSource="<%# Eval ("'Refinements') %>">

<ltemTemplate>
<a
style=""margin-left: 10px"
href="<%# UrIManager .Default._Urls._.SelectDimensionVal-
ue(dsLeft.ID,
Container.Dataltem) %>">
<%# Eval('DisplayName') %>
</a> <br />
</ltemTemplate>
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</asp:Repeater>
</l1temTemplate>
</asp:Repeater>

Building a URL to a record details page

You can build a URL for a record details page by calling the convenience method Ur1Bui lder .Se—
lectRecord. This method requires a record details data source ID and a record object as input. You
can build the URL on the current page of an application, for example, Default.aspx, or you can
build a URL that links to another page such as RecordDetali Is.aspx by setting the page name in
the UrIManager .BaseUr |1 property.

The example below requires the following statements in your code:

using System;

using Endeca.Data;
using Endeca.Web.Ul;
using RadAspNetRef;
using Endeca.-Web._Url;

This procedure also assumes you have already created data sources or commands in your application
and assigned them an ID.

To build a URL to a record details page:

1. Create a repeater control and specify RecordsResul t as the DataMember property.

%
Note: You are not required to create a repeater to call SelectRecord. Also, steps 1 and
2 are in the procedure to provide context for a typical use case. If you do not need this context,
you can skip to step 3.

2. Create a nested repeater control and specify the data source, in this case, Records.
3. Create a hyperlink, and within it, call SelectRecord.
4. Provide SelectRecord with input parameters that specify the ID of the record details data source

and the Endeca record to build the URL for.
See the first example below for the markup.

5. In the code behind for the markup, do the following:

a) If you want to build a URL to a page different from the current page, specify a relative path to
the application root in the UrIManager .BaseUr 1 property. This property value should begin
with a tilde then slash (~/) followed by a path relative to the root of the Web application.

b) Create a UrIManager on the record details page indicated by Ur IManager .BaseUrl.

¢) Register a RecordDetai IsDataSource on the record details page by calling Ur IManag-
er.Register and provide a record details data source (or command). This call is usually done
as part of page configuration during a page's Page_Load or OnlInit methods.

d) Call InitializeFrom and provide the Request.Url.

See the second example below for the code behind.

6. Register each data source in the application by calling Register and specifying each data source
ID.
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Example of building a record details page URL

This example shows the markup that calls SelectRecord to build a record details URL. Note that
for the example, recDetai IsDataSource. 1D is pseudo-code. Your mark up should refer to a
record details data source either as a string or by its ID.

<asp:Repeater ID="rptRecordResult" runat="'server' DataMember="RecordsResult"

DataSourcelD=""NavDataSource'>
<ltemTemplate>
<asp:Repeater ID="'rptRecord" runat="'server' Data-
Source="<W#Eval ("'Records') %>">
<ltemTemplate>
<div>
<asp:HyperLink ID="HyperLink2" NavigateUrl="<%#
UrIManager .Get("'recDetai lsUrIManager') .Urls_SelectRecord
(recDetai lsDataSource. 1D, Container.Dataltem) %>"
runat="'server'>
<%# GetRecordTitle(Container_Dataltem) %>
</asp:HyperLink>
</div>
</l1temTemplate>
</asp:Repeater>
</ltemTemplate>
</asp:Repeater>

This example shows the code behind that supports the mark up. This is in the page's Page_Load
method. Note the use of BaseUr1 that builds the link on the RecordDetai ls.aspx page.

recDetai lsDataSource = new RecordDetailsDataSource();
recDetailsDataSource. ID = "recDetailsDataSource';

UrIManager .Get("'recDetai lsUrIManager') .BaseUrl =
""~/Records/RecordDetails.aspx";

UrIManager .Get("'recDetai lsUr IManager™) .Register (NavDataSource) ;

UrIManager .Get("'recDetai lsUrIManager') .Register(recDetai lsDataSource) ;

UrIManager .Get("'Defaul tPageManager'™) .Register(NavDataSource);
UrIManager .Get("'Defaul tPageManager'™) . InitializeFrom(Request.Url);

Building a URL to an aggregate record details page

You can build a URL for an aggregate record details page by calling the convenience method Ur -
Bui lder.SelectAggregateRecord. This method requires an aggregate record details data source
ID and an aggregate record object as input. You can build the URLthat links to the current page of an
application, for example, Default.aspx, or you can build a URL that links to another page such as
AggRecordDetai Is.aspx by setting the page name in the Ur IManager .BaseUr |1 property.

The example below requires the following statements at the top of your code behind:
using System;

using Endeca.Data;

using Endeca.Web.Ul;

using RadAspNetRef;

using Endeca.Web.Url;

This procedure also assumes you have already created data sources or commands in your application
and assigned them an ID.
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To build a URL to an aggregate record details page:

1. Create arepeater control and specify AggregateRecordsResult as the DataMember property.

%
Note: You are not required to create a repeater to call SelectAggregateRecord. Also,
steps 1 and 2 are in the procedure to provide context for a typical use case. If you do not
need this context, you can skip to step 3.

2. Create a nested repeater control and specify the data source, in this case, AggregateRecords.

3. Create a hyperlink and in a data binding expression, assign Ur IManager . SelectAggregateRe-
cord to the NavigateUr|1 property.

4. Provide SelectAggregateRecord with input parameters that specify the ID of the aggregate
record details data source, the navigation data source, and the Endeca aggregate record to build
the URL for.

See the first example below for the markup.

5. In the code behind for the markup, do the following:
a) If you want to build a URL to a page different from the current the page, specify a relative path
to the application root in the Ur IManager .BaseUr I property. This property value should begin
with a tilde then slash (~/) followed by a path relative to the root of the Web application.

b) Create a UrIManager on the aggregate record details page indicated by Ur IManag-
er _BaseUrl.

¢) Register a Ur IManager on the aggregate record details page by calling Ur IManager .Regis-
ter and provide an aggregate record details data source (or command). This call is usually
done as part of page configuration during a page's Page_Load or Onlnit methods.

d) Call InitializeFrom and provide the Request._Url.

See the second example below for the code behind.

6. Register each data source in the application by calling Register and specifying each data source
ID.

Example of building an aggregate record details page URL

This example shows the mark up that calls SelectAggregateRecord to build an aggregate record
details URL. Note that for the example, aggRecDetai IsDataSource. ID and NavDataSource. 1D
is pseudo-code. Your markup should refer to an aggregate record details data source and navigation
data source either as a string or by its ID.

<asp:Repeater ID=""Repeater3" runat="'server' DataMember=""AggregateRecordsRe—
sult”
DataSourcelD=""NavDataSource'>
<ltemTemplate>
<asp:Repeater ID="'rptRecord" runat="server' DataSource="<%#Eval ("'Ag-
gregateRecords'™) %>">
<ltemTemplate>
<div>
<asp:HyperLink ID="HyperLinkl" NavigateUrl="<%# UrlIManag-
er.Get
("'aggRecDetai IsUrIManager™) .Urls.SelectAggregateRecord
(aggRecDetai IsDataSource. I1D,NavDataSource. ID, Contain-
er.Dataltem)
%>" runat="'server'>
<%# GetRecordTitle(Container_Dataltem) %>
</asp:HyperLink>
</div>
</ltemTemplate>
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</asp:Repeater>
</l1temTemplate>
</asp:Repeater>

This example shows the code behind that supports the mark up. This is in the page's Page_Load
method. Note the use of BaseUr| that builds the link on the RecordDetai ls.aspx page.

aggRecDetai lsDataSource = new AggregateRecordDetailsDataSource();
aggRecDetai IsDataSource. ID = "aggRecDetai lsDataSource™;

UrIManager .Get("'aggRecDetai lsUrIManager') .BaseUrl =
""~/AggRecords/AggRecordDetai ls.aspx';

UrIManager .Get("'aggRecDetai IsUrIManager'™) .Register(NavDataSource);

UrIManager .Get(*'aggRecDetai IsUr IManager') .Register (aggRecDetai IsDataSource) ;

UrIManager .Get('Defaul tPageManager') .Register (NavDataSource);
UrIManager .Get("'Defaul tPageManager ') .InitializeFrom(Request._Url);

Building a URL using the BuildUrl method

In addition to the convenience methods in Ur 1Bui Ider that build URLSs, such as SelectParentDi—
mensionValue, SelectDimensionValue, SelectRecord, and so on, you can also use Url-
Bui lder .BuildUrl method to construct a URL. This method provides a flexible way to customize
URLs if the convenience methods are not suitable.

The example below requires the following statements at the top of your code:

<%@ Register TagPrefix="end" Assembly=""Endeca.Web"
Namespace=""Endeca.Web.UIl" %>
<%@ Register TagPrefix="end" Assembly="Endeca.Web.Ul_WebControls"
Namespace=""Endeca.-Web_UI" %>
<%@ Import Namespace='"Endeca.Data" %>
<%@ Import Namespace="Endeca.Web._Url" %>

This procedure assumes you have already created data sources or commands in your application and
assigned them an ID.

The Url1Bui lder.Bui ldUrl method takes a delegate that takes a CommandActionlInfo.You write
the body of the delegate to copy an EndecaCommand, using CommandActionlInfo.Get<T> and
then modify the copy so it can serve as the basis for a new URL.

To build a URL using Bui 1dUr1:

1. Add code that calls Bui 1dUrl on the UrIManager.
2. Create a delegate that takes CommandActioninfo.

3. In the delegate, add code to copy an EndecaCommand by calling Get and then specifying a data
source ID as input.

This copy becomes the basis of a new URL.
4. Add additional code to configure the URL as desired. There is a large amount of potential

configuration you could perform at this point to build a URL. It may be useful to browse the examples
in the reference application for typical use cases.

5. Optionally, add parameters to a URL. See the "Adding parameters ..." topics.
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Example building a URL

This example shows the markup for a URL that clears all the dimensions and dimension values when
an end user clicks Reset.

<a
href="<%= UrlIManager.Default.Urls.BuildUrl(delegate(CommandActionlinfo
D {
NavigationCommand cmd = i.Get<NavigationCommand>( dsRight.ID );
cmd.RefinementConfigs.Clear();
cmd.SelectedDimensionValuelds.Clear(); }) %>">
Reset
</a>

Adding parameters to all URLs produced by a UrIManager

You can add parameters to all the URLs produced by a particular instance of a UrIManager. This
approach provides a way to add parameters to URLSs produced by an instance of a UrIManager
rather than adding parameters on a per-URL basis using the Ur1Bui lder.BuildUrl. The manner
in which these parameters are encoded in the URL depends on the UrIProvider implementation
associated with the UrIManager.

The example below requires the following statements in your code:

using System;

using Endeca.Data;
using Endeca.Web.Ul;
using RadAspNetRef;
using Endeca.Web.Url;

This procedure also assumes you have already created data sources or commands in your application
and assigned them an ID.

To add parameters to all URLs produced by a Ur IManager:

1. Create a UrIManager and register data sources or commands with it. For details, see "Creating
a UrIManager and registering data sources and commands".

2. Initialize the Ur IManager. For details, see "Initializing a UrIManager".

3. Call the Add method and provide a string specifying the key-value pair for the parameter you want
to add. Repeat for any additional parameters you want the Ur IManager to create.

Example of adding parameters to all URLs

This example shows the code to check if a URL has a Session D parameter. If not, it adds the
SessionlIDto all URLs produced by the Ur IManager. This code is in the page's Page_Load method.

// The APl provides a convenience method called Default

// to create a new instance of UrIManager named "Default'.
// This creates a UrlIManager and registers two data sources
// with it.

UrIManager .Default_Register(dsLeft);

UriIManager .Default_Register(dsRight);

// Provide the UrlIManager with state from the Request.Url.
UriIManager .Default. InitializeFrom(Request.Url);

// Logic to check if the SessionlD parameter is
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// in the collection of UrlIManager parameters.
// If not, add a SessionlD parameter to the UrlIManager.
UrIManager .Defaul t.Parameters[SessionlID] = 1234;

This BasicUrlIProvider produces a URL that encodes the contains the SessionlD parameter
as a query string parameter, as shown:

http://1ocalhost:3932/RadAspNetRef/Ur1 _aspx
?dsLeft=Nrc:id-7&amp;SessionlD=1234

Adding parameters to a URL on a per-URL basis

You can add parameters on a per-URL basis by calling Ur1Bui Ider.Bui IdUrl and specifying one
or more key-value parameters as input.

The example below requires the following statements in your code:
<%@ Register TagPrefix="end" Assembly=""Endeca.Web"
Namespace=""Endeca.Web.UIl" %>
<%@ Register TagPrefix="end" Assembly="Endeca.Web.Ul_WebControls™
Namespace=""Endeca.-Web_UI" %>
<%@ Import Namespace='"Endeca.Data" %>
<%@ Import Namespace="Endeca.Web.Url" %>

This procedure assumes you have already created data sources or commands in your application and
assigned them an ID.

To add parameters to a URL on a per-URL basis:

1. Create a link object that calls Bui 1dUrl.
The example below does this in the markup rather than code behind.

2. Call the Add method and provide a string specifying the key-value pair for the parameter you want
to add. Repeat for any additional parameters you want Bui 1dUr 1 to create.

Example of adding parameters to a single URL

This example shows the code to add the keystring parameter to the URL produced by clicking on
LinkName.

href="<%= UrlIManager.Default.Urls._.BuildUrl(delegate(CommandActionInfo 1)

i .Parameters. [keystring]="valuestring";
} ) %>
LinkName

This code produces a URL for LinkName that contains the keystring parameter, as shown:
http://localhost:port/RadAspNetRef/Url .aspx?keystring=valuestring
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Chapter 6
Using the RAD API for programmatic
querying

This section provides examples of how to use the RAD API to programmatically query an MDEX Engine
using all of the basic query types. The examples build each type of Command object and execute the
command. The MDEX Engine returns a NavigationResult object to your application.

Executing a navigation command

This example code connects to an MDEX Engine, creates and executes a NavigationCommand,
and examines various ways that the output types can be used. Note that the NavigationCommand
object is the most efficient command to be used when seeking multiple result collections from a query.

This example requires the following includes at the top of your code:

using System.Collections.ObjectModel ;

using System.Collections.Generic;

using Endeca.Data;

using Endeca.Data.Provider;

using Endeca.Data.Provider.PresentationApi;

To build a NavigationCommand

Add code similar to following example:

// A PresentationApiConnection is an EndecaConnection that uses the

// legacy presentation APl as a transport.

// Future EndecaConnections can use XQuery or other transport mechanisms
PresentationApiConnection conn = new PresentationApiConnection('localhost’,

8000) ;
// A NavigationCommand represents a query to the engine that requests
everything
//except record/aggregate record details and single/compound dimension
search

NavigationCommand cmd = new NavigationCommand(conn);
// ...additional code not shown to set Navigation Command values...

// NavigationResult contains Records, AggregateRecords, Dimensions,
Breadcrumbs,

// Analytics, BusinessRules, MetaData, and Supplemental Objects
NavigationResult res = cmd.Execute();
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/// Example using Records output types
RecordsResult recordsRes = res.RecordsResult;

// How many total records there are for this navigation state

long totalNumberOfRecords = recordsRes.TotalRecordCount;
ReadOnlyCollection<Record> records = recordsRes.Records;

// loop through each record and get some variables that we might want to
output

foreach (Record r in records)

string name = r["P_Name'"]; // get string value for property P_Name
string vintage = r["Vintage']; // works for dimensions (Vintage), too

// This collection has all dimension values for the Flavors dimension

ReadOnlyCollection<DimensionValue> dimvals = r.DimensionValues.ByDi-
mensionName["'Flavors'] ;
foreach (DimensionValue dv in dimvals)

string dimensionValueName = dv.Name; // the name of each flavor

// In order to select one of the DimensionValues simply add it to
a NavigationCommand
// cmd.SelectDimensionValue(dv);
}

}

//7/

/// Example using DimensionState output types

//7/

DimensionStatesResult dimensionRes = res.DimensionStatesResult;

// IndexedCollection is just like a normal collection except it has lookup
by Name

// or 1d RefinableDimensionStates are DimensionStates that have refinements

// and are neither fully selected or fully implicit

IndexedCol lection<DimensionState> dimensionStates = dimensionRes.Refin-
ableDimensionStates;

foreach (DimensionState d in dimensionStates)

{

string dimensionName = d.Dimension.DisplayName;

// loop through available refinement dimension values for this dimension
state

// note that choices are only available if the dimension is expanded

foreach (DimensionValue dv in d.Refinements)

{
string dimensionValueName = dv.Name;
// In order to select one of the DimensionValues simply add it to
a
// NavigationCommand
cmd.SelectDimensionValue(dv);
}
}
///

/// Example using applied filters to output selected dimension values as
breadcrumbs
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//7/

AppliedFiltersResult filtersResult = res._AppliedFiltersResult;

// for this example, we only care about selected dimension values

DimensionValueCollection selectedDimensionValues = filtersResult.Dimen-

sionValues;

// each dimension value knows its path from the root dimension value to
itself

foreach (DimensionValue dimval in selectedDimensionValues)

// for each dimension value, we"ll use its path to get out the variables
needed to make a

// breadcrumb with [Remove] on the left that will remove the whole
breadcrumb,

// and links under each dimension value in the middle to navigate back

// up the hierachy to that location.
// For example: "[Remove] Wine Type > Red > Beaujolais
DimensionValuePath dimvalPath = dimval.DimensionValuePath;

// We can use the encoded state of the DimensionValue to perform oper-
ations
// on the state such as removing, adding, and selecting ancestors

// Remove in this example removes the last dimension value in the
breadcrumb
string removeContext = dimvalPath.Last.ContextPath;

// The removal can be performed by calling Remove on the Navigation-
Command

// with either the full DimensionValue or the context path.

// The context path is useful when you will not have the full Dimen-
sionValue object

// cmd._RemoveDimensionValue(removeContext) ;

// or

// cmd.RemoveDimensionValue(dimvalPath.Last);

string rootName = dimvalPath._First._Name;
// the intermediate dimension values are between the root and descriptor

foreach (DimensionValue intermediate in dimvalPath.Intermediates)

{
string intermediateName = intermediate.Name;
// when you click on the intermediate dimension value you®ll navigate
there
string selectContext = intermediate.ContextPath;
// cmd.SelectDimensionValue(selectContext);
// or
// cmd.SelectDimensionValue(intermediate);

string descriptorName = dimvalPath.Last.Name;

}

Executing a records detail query

This example executes a query using a record ID as input and returns the corresponding single record.
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This example requires the following includes at the top of your code:

using System.Collections.ObjectModel;

using System.Collections.Generic;

using Endeca.Data;

using Endeca.Data.Provider;

using Endeca.Data.Provider.PresentationApi;

To connect to an MDEX Engine and execute a records detail query:

Add code similar to following example:

PresentationApiConnection conn = new PresentationApiConnection(*'localhost™,
8000) ;
RecordDetailsCommand r = new RecordDetailsCommand(conn);

r.ldentifier = ""45728";

Record rec = r.Execute();

Executing an aggregated records query

This example executes an aggregated records query against the MDEX Engine and returns a single
AggregateRecord.
This example requires the following includes at the top of your code:

using System_Collections.ObjectModel;

using System.Collections.Generic;

using Endeca.Data;

using Endeca.Data.Provider;

using Endeca.Data.Provider.PresentationApi;

To connect to an MDEX Engine and execute an aggregated records query:

Add code similar to following example:

PresentationApiConnection conn = new PresentationApiConnection(‘'localhost",
8000);

AggregateRecordDetai lsCommand cmd = new AggregateRecordDetailsCom-
mand(conn) ;

cmd.AggregationKey = "P_Winery";
cmd. ldentifier = "43444";

AggregateRecord arec = cmd.Execute();

Executing a dimension search query

This example executes a dimension search query against an MDEX Engine and returns name, ID,
group, and child dimension values.
This example requires the following includes at the top of your code:

using System_Collections.ObjectModel;
using System.Collections.Generic;
using Endeca.Data;
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using Endeca.Data.Provider;
using Endeca.Data.Provider.PresentationApi;

To connect to an MDEX Engine and execute a dimension search query:

Add code similar to following example:

PresentationApiConnection conn = new PresentationApiConnection('localhost",
8000);
DimensionSearchCommand dsc = new DimensionSearchCommand(conn);

// Search for any dimension values with either any of "red" or "drink"
in them

dsc.SearchTerms = "red drink";

dsc.SearchMode = SearchMode.Any;

DimensionSearchResult dsr = dsc.Execute();

// The results are in one large dimension value collection but can be
grouped

// by dimension name or dimension id
ReadOnlyDictionary<string,ReadOnlyCol lection<DimensionValue>> byDimension

dsr.DimensionValues.ByDimensionName;

// You can iterate over the dictionary and print out the name of the di-
mension

// and all the results beneath it.

foreach (KeyValuePair<string, ReadOnlyCollection<DimensionValue>> pair
in byDimension)

string dimensionName = pair.Key;
foreach (DimensionValue dval in pair.Value)

string dimensionValueName = dval.Name;
System._Diagnostics.Debug.WriteLine(string.Format(*'{0} -> {1}",
dimensionName, dimensionValueName));

Executing a compound dimension search query

This example executes a dimension search query against an MDEX Engine and returns the set of
dimension values that match.
This example requires the following includes at the top of your code:

using System.Collections.ObjectModel;

using System.Collections.Generic;

using Endeca.Data;

using Endeca.Data.Provider;

using Endeca.Data.Provider.PresentationApi;

To connect to an MDEX Engine and execute a compound dimension search query:

Add code similar to following example:

PresentationApiConnection conn = new PresentationApiConnection(*'localhost",
8000);
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CompoundDimensionSearchCommand dsc = new CompoundDimensionSearchCom-
mand(conn) ;

// Search for sets of dimension values with "red" and "drink'™ in them
dsc.SearchTerms = "red drink";

CompoundDimensionSearchResult dsr = dsc.Execute();

// The results are DimensionValueCollections where each value matches
one of the terms in the search
ReadOnlyCollection<DimensionValueCollection> compoundDimVals = dsr.Com-
poundDimensionValues;

foreach(DimensionValueCollection dvcol in compoundDimVals)

// The contents of this loop are a single compound result
int count = O;
foreach (DimensionValue dval in dvcol)

System._Diagnostics.Debug.-Write(string.Format("'{0} -> {1} ",
dval .Dimension.Name, dval _Name));

if (count++ < dvcol.Count-1)

System.Diagnostics.Debug.Write(* and ');

System.Diagnostics.Debug.WriteLine(""");
}

Executing a metadata query

This example executes a metadata query and returns key properties, search keys, sort keys and roll
up keys (aggregation keys).
This example requires the following includes at the top of your code:

using System._Collections.ObjectModel;

using System.Collections.Generic;

using Endeca.Data;

using Endeca.Data.Provider;

using Endeca.Data.Provider.PresentationApi;

To connect to an MDEX Engine and execute a metadata query:

Add code similar to following example:

PresentationApiConnection conn = new PresentationApiConnection(‘'localhost",
8000);
MetadataCommand mdc = new MetadataCommand(conn);

MetadataResult mdr = mdc.Execute();
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Chapter 7
Integrating a preview application into
Endeca Workbench

This section describes how to integrate either the RAD ASP.NET reference application or a custom
application into Endeca Workbench (known as Web Studio prior to version 6.0.x). Once integrated,
an application becomes the preview application that you use to test dynamic business rules.

Integrating the RAD ASP.NET reference application into
Endeca Workbench

In a default Endeca IAP installation, the JSP reference application is incorporated into the Rule Manager
page of Endeca Workbench. The JSP reference application acts as the preview application for working
with dynamic business rules. You can however substitute the RAD ASP.NET reference application in

place of the JSP reference application and use the RAD reference application as the preview application.

Before starting the task below, make sure your reference application is running.

You integrate the RAD ASP.NET reference application into Endeca Workbench by changing the URL
mappings on the Preview App Settings page of Endeca Workbench.

S
7~ Note: The URL mode and RAD Toolkit Server Controls URL modes are both supported in
Endeca Workbench. The Postback and RAD Toolkit Server Controls Postback modes are not
supported in Endeca Workbench.

To integrate the RAD ASP.NET reference application into Endeca Workbench:

1. Log in to Endeca Workbench, and under Application Settings, select the Preview App Settings
page.

2. Replace the URL Mapping values with the following URLS:
URL Type Example URL Mapping

Search http://hostname:port/RAD/GuidedNavigationUrlServerControls.aspx?En-

URL decaHostName=MDEXEngineHost&EndecaPort=MDEX~
EnginePort&dsNav=Ntk: ${key}%7c${terms}%7cl%7c,Nmpt:${preview-
time},Nmrf:${rulefilter}

Navigation http://hostname:port/RAD/GuidedNavigationUrlServerControls.aspx?En-
URL decaHostName=MDEXEngineHost&EndecaPort=MDEX~
EnginePort&dsNav=N:${nav},Nmpt:${previewtime} , Nmrf:${rulefilter}
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URL Type Example URL Mapping
Search http://hostname:port/RAD/GuidedNavigationUrlServerControls.aspx?En-

and decaHostName=MDEXEngineHost&EndecaPort=MDEX~

Navigation EnginePort&dsNav=Ntk:${key}n7c${terms}%7cl%7c,N:${nav},Nmpt:${pre-
URL viewtime},Nmrf:${rulefilter}

Record  http://hostname:port/RAD/GuidedNavigationUrlServerControls.aspx?En-
URL decaHostName=MDEXEngineHost&EndecaPort=MDEXEnginePort&dsRecordDe-

tails=R:${record}

Notes:

« If you copy the URLSs, remove the line breaks when you paste them into Endeca Workbench.

* The syntax of the URL mappings is documented in the Endeca Workbench Help. See "Providing
or confirming preview application URLS".

« In the examples above, the directory /RAD refers to the virtual directory name of the RAD
ASP.NET reference application. The page name for the reference application can be either
GuidedNavigationUrIServerControls.aspx (as in the examples) or GuidedNavigationUrl.aspx.

3. You may also need to declare the Javascript domain in GuidedNavigationUrlServerControls.aspx
or GuidedNavigationUrl.aspx (depending on which page you specified in the Preview App Settings
page in Endeca Workbench). For details, see the Endeca Workbench Administrator's Guide.

4. On the Preview App Settings page, click Save Changes.
5. Navigate to the Rule Manager page.

The RAD ASP.NET reference application displays in the preview application pane.

Integrating a custom application into Endeca Workbench

In a default Endeca IAP installation, the JSP reference application is incorporated into the Rule Manager
page of Endeca Workbench. The JSP reference application acts as the preview application for working
with dynamic business rules. You can however substitute your own custom application in place of the
JSP reference application and use it as the preview application.

You integrate a custom application into Endeca Workbench by changing the URL mappings in Endeca
Workbench, by enabling WebStudioCommandSerializationProvider, and by adding
instrumentation server controls.

>
7~ Note: The URL mode and RAD Toolkit Server Controls URL modes are both supported in
Endeca Workbench. The Postback and RAD Toolkit Server Controls Postback modes are not
supported in Endeca Workbench.

To integrate a custom application into Endeca Workbench:

1. Navigate to the reference\RadAspNetRef\App_Code\RadAspNetRefUr1 subdirectory of
your RAD Toolkits installation.

For example:
C:\Endeca\RADToolkits\version\ASP.NET\reference\RadAspNetRe\App_Code\RadAspNetRefUrl

2. Copy the WebStudioUr1CommandSerializationProvider.cs file to the App_Code directory
of your application.
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3. Open the Web.config file for the custom application that you want to integrate into Endeca
Workbench. In the <configSections> element, add the following snippet:
<configSections>

<sectionGroup name="endeca'" type="Endeca.Data.Configuration.EndecaSec-
tionGroup,
Endeca.Data, Version=2.1.0.0, Culture=neutral, PublicKeyTo-
ken=6d02be8724ca751c" >
<section name="‘commandSerialization”
type="Endeca.Data.Configuration.CommandSerializationSection,
Endeca.Data, Version=2.1.0.0, Culture=neutral, PublicKeyTo-
ken=6d02be8724ca751c" />

4. Also in the Web.conTfig file, add the following snippet immediately after the <endeca> element:

<endeca>
<commandSerialization>
<providers>
<add name="Url" type="RadAspNetUrIRef._WebStudioUrlCommandSerial-
izationProvider™"™ />
</providers>
</commandSerialization>

<I-- Other elements removed from the example. -->

</endeca>

For an example, see the Web . conTig file for the RAD ASP.NET reference application.

5. Open the home page for your custom application, or any page in your application that requires

instrumentation, and do the following:

a) For navigation instrumentation, drag the WebStudioNavigationinstrumentation control on to
the Design tab of your page.

b) From the Smart Tag of the WebStudioNavigationlnstrumentation control, select the
NavigationDataSource data source.

¢) Forrecord instrumentation, drag the WebStudioRecordIinstrumentation control on to the
Design tab of your page.

d) From the Smart Tag of the WebStudioRecordInstrumentation control, select the
RecordDetailsDataSource data source.

e) Inthe markup for the WebStudioRecordInstrumentation control, modify the RecordSpecProp-
erty to reflect the spec ID of records in your data set, and the RecordNameProperty properties
to reflect the name.

] . .
~ Note: You may also need to declare the Javascript domain for the pages that are
instrumented. For details, see the Endeca Workbench Administrator's Guide.

6. Log in to Endeca Workbench, and under Application Settings, select the Preview App Settings
page.

7. Replace the URL Mapping values with the following URLS:
URL Type Example URL Mapping
Search http://hostname:port/AppName/PageName . aspx?EndecaHostName=MDEX~
URL EngineHost&EndecaPort=MDEX-

EnginePort&dsNav=Ntk:${key}%7c${terms}%7cl%7c,Nmpt:${preview-
time},Nmrf:${rulefilter}
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URL Type Example URL Mapping

Navigation http://hostname:port/AppName/PageName .aspx?EndecaHostName=MDEX~
URL EngineHost&EndecaPort=MDEXEnginePort&dsNav=N:${nav},Nmpt:${pre-
viewtime} ,Nmrf:${rulefilter}

Search http://hostname:port/AppName/PageName . aspx?EndecaHostName=MDEX~

and EngineHost&EndecaPort=MDEX-

Navigation EnginePort&dsNav=Ntk:${key}»7c${terms}%7cl%7c,N:${nav},Nmpt:${pre-
URL viewtime},Nmrf:${rulefilter}

Record http://hostname:port/AppName/PageName.aspx?EndecaHostName=MDEX~
URL EngineHost&EndecaPort=MDEXEnginePort&dsRecordDetai ls=R:${record}
Notes:

« If you copy the URLSs, remove the line breaks when you paste them into Endeca Workbench.

« The syntax of the URL mappings are documented in the Endeca Workbench Help. See "Providing
or confirming preview application URLS".

« In the examples above, the directory /AppName refers to the virtual directory name of the
custom application. The file PageName.aspx refers to the home page of your application.

8. On the Preview App Settings page, click Save Changes.
9. Navigate to the Rule Manager page of Endeca Workbench.

The custom application displays in the preview application pane.
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